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Copyright

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of
Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the use of the information herein. The
information contained herein is designed only for use with this Epson product. Epson is not responsible for any
use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or
abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.)
failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of
any options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko
Epson Corporation.

© 2017 Seiko Epson Corporation

The contents of this manual and the specifications of this product are subject to change without notice.



User's Guide

Trademarks

Trademarks

[J EPSONB® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a
trademark of Seiko Epson Corporation.

(4 PRINT Image Matching™ and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation.
Copyright © 2001 Seiko Epson Corporation. All rights reserved.

[d Epson Scan 2 software is based in part on the work of the Independent JPEG Group.
1 libtiff

Copyright © 1988-1997 Sam Leftler

Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics
may not be used in any advertising or publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED
OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

(d SDXC Logo is a trademark of SD-3C, LLC.

Y 4
xXC

d Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

[d Apple, Macintosh, Mac OS, OS X, Bonjour, Safari, iPad, iPhone, iPod touch, and iTunes are trademarks of Apple
Inc., registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

[d Google Cloud Print, Chrome, Chrome OS, and Android are trademarks of Google Inc.
d QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and other countries.

[d Adobe and Adobe Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the
United States and/or other countries.

[ Intel® is a registered trademark of Intel Corporation.

[d General Notice: Other product names used herein are for identification purposes only and may be trademarks
of their respective owners. Epson disclaims any and all rights in those marks.
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About This Manual

About This Manual

Introduction to the Manuals

The following manuals are supplied with your Epson printer. As well as the manuals, check the various types of
help information available from the printer itself or from the Epson software applications.

[ Start Here (paper manual)

Provides you with information on setting up the printer, installing the software, using the printer, solving
problems, and so on.

(d User's Guide (digital manual)
This manual. Provides overall information and instructions on using the printer, on network settings when

using the printer on a network, and on solving problems.

You can obtain the latest versions of the above manuals with the following methods.

(A Paper manual

Visit the Epson Europe support website at http://www.epson.eu/Support, or the Epson worldwide support
website at http://support.epson.net/.

(J Digital manual

Start EPSON Software Updater on your computer. EPSON Software Updater checks for available updates of
Epson software applications and the digital manuals, and allows you to download the latest ones.

Related Information
= “EPSON Software Updater” on page 127

Using the Manual to Search for Information

The PDF manual allows you to search for information you are looking for by keyword, or jump directly to specific
sections using the bookmarks. You can also print only the pages you need. This section explains how to use a PDF
manual that has been opened in Adobe Reader X on your computer.

Searching by keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you want to find in the search window,
and then click Search. Hits are displayed as a list. Click one of the displayed hits to jump to that page.

..........
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Jumping directly from bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in that section. To return to the previous
page, perform the following operation on your keyboard.

(4 Windows: Hold down Alt, and then press <.
(4 Mac OS: Hold down the command key, and then press <.

User's Guide

Printing only the pages you need

You can extract and print only the pages you need. Click Print in the File menu, and then specify the pages you
want to print in Pages in Pages to Print.

[ To specify a series of pages, enter a hyphen between the start page and the end page.
Example: 20-25

[ To specify pages that are not in series, divide the pages with commas.
Example: 5, 10, 15

Help @
Copies: |1 = [C1Prnt in grayscale (black and white)
[l 5ave inkitener (0

Cammen s B Farems

Document an d Markups

Seale: 9T%

827 x 1169 Inches.

(@) Pages 5
Page Sizing & Handing (0
Size Paster Multiple Eoaklet eSO |

Marks and Symbols

A Caution:

Instructions that must be followed carefully to avoid bodily injury.

g Important:

Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.

= Related Information
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Links to related sections.

Descriptions Used in this Manual

(4 Screenshots of the printer driver and the Epson Scan 2 (scanner driver) screens are from Windows 10 or macOS
High Sierra. The content displayed on the screens varies depending on the model and situation.

[ Tllustrations of the printer used in this manual are examples only. Although there may be slight differences
depending on the model, the method of operation is the same.

[d Some of the menu items on the LCD screen vary depending on the model and settings.

Operating System References

Windows

In this manual, terms such as "Windows 10", "Windows 8.1", "Windows 8", "Windows 7", "Windows Vista", and
"Windows XP" refer to the following operating systems. Additionally, "Windows" is used to refer to all versions.

[d Microsoft® Windows® 10 operating system
[J Microsoft® Windows® 8.1 operating system
[d Microsoft® Windows® 8 operating system

d Microsoft® Windows® 7 operating system

(d Microsoft® Windows Vista® operating system
d Microsoft® Windows® XP operating system

[d Microsoft® Windows® XP Professional x64 Edition operating system

Mac OS

In this manual, "Mac OS" is used to refer to macOS High Sierra, macOS Sierra, OS X El Capitan, OS X Yosemite,
OS X Mavericks, OS X Mountain Lion, Mac OS X v10.7.x, and Mac OS X v10.6.8.

10
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Important Instructions

Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this printer. Make sure you keep this manual for future
reference. Also, be sure to follow all warnings and instructions marked on the printer.

[d Some of the symbols used on your printer are to ensure safety and proper use of the printer. Visit the following
Web site to learn the meaning of the symbols.

http://support.epson.net/symbols

(4 Use only the power cord supplied with the printer and do not use the cord with any other equipment. Use of
other cords with this printer or the use of the supplied power cord with other equipment may result in fire or
electric shock.

(d Be sure your AC power cord meets the relevant local safety standard.

[d Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by
yourself, except as specifically explained in the printer's manuals.

(J Unplug the printer and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the casing
damaged; the printer does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

[ Place the printer near a wall outlet where the plug can be easily unplugged.

(A Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in locations
subject to shocks, vibrations, high temperature or humidity.

(d Take care not to spill liquid on the printer and not to handle the printer with wet hands.

(d Keep the printer at least 22 cm away from cardiac pacemakers. Radio waves from this printer may adversely
affect the operation of cardiac pacemakers.

[ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

[d Be careful when you handle used ink cartridges, as there may be some ink around the ink supply port.
[ If ink gets on your skin, wash the area thoroughly with soap and water.

1 If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after
a thorough flushing, see a doctor immediately.

[ If ink gets into your mouth, see a doctor right away.

[d Do not disassemble the ink cartridge; otherwise ink may get into your eyes or on your skin.

[d Do not shake ink cartridges too vigorously and do not drop them. Also, be careful not to squeeze them or tear
their labels. Doing so may cause ink leakage.

[J Keep ink cartridges out of the reach of children.

1
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Printer Advisories and Warnings

Read and follow these instructions to avoid damaging the printer or your property. Make sure you keep this
manual for future reference.

Advisories and Warnings for Setting Up/Using the Printer

(d Do not block or cover the vents and openings in the printer.

[d Use only the type of power source indicated on the printer's label.

[d Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
(4 Avoid electrical outlets controlled by wall switches or automatic timers.

[ Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

(4 The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over.
Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter
and leave the transformer.

[ If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord's ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

[ If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the printer.

(d When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation
may damage both devices connected by the cable.

[J Place the printer on a flat, stable surface that extends beyond the base of the printer in all directions. The printer
will not operate properly if it is tilted at an angle.

[d When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

(d Allow space above the printer so that you can fully raise the document cover.
[d Leave enough space in front of the printer for the paper to be fully ejected.

[d Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct
sunlight, strong light, or heat sources.

(d Do not insert objects through the slots in the printer.

(d Do not put your hand inside the printer during printing.

(d Do not touch the white flat cable inside the printer.

(d Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
(4 Do not move the print head by hand; otherwise, you may damage the printer.

[d Be careful not to trap your fingers when closing the scanner unit.

(d Do not press too hard on the scanner glass when placing the originals.

[d Always turn the printer off using the O button. Do not unplug the printer or turn off the power at the outlet
until the O light stops flashing.

12
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[ Before transporting the printer, make sure that the print head is in the home (far right) position and the ink
cartridges are in place.

[ If you are not going to use the printer for a long period, be sure to unplug the power cord from the electrical
outlet.

Advisories and Warnings for Using the Printer with a Wireless
Connection

[d Radio waves from this printer may negatively affect the operation of medical electronic equipment, causing
them to malfunction. When using this printer inside medical facilities or near medical equipment, follow

directions from the authorized personnel representing the medical facilities, and follow all posted warnings and
directions on the medical equipment.

[J Radio waves from this printer may negatively affect the operation of automatically controlled devices such as
automatic doors or fire alarms, and could lead to accidents due to malfunction. When using this printer near
automatically controlled devices, follow all posted warnings and directions on these devices.

Advisories and Warnings for Using Memory Cards

(d Do not remove a memory card or turn off the printer while the memory card light is flashing.

(J The methods for using memory cards vary according to card type. Be sure to refer to the manual packaged with
your memory card for details.

(d Use only memory cards compatible with the printer.

Related Information

= “Supported Memory Card Specifications” on page 162

Advisories and Warnings for Using the LCD Screen

[d The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

(d Only use a dry, soft cloth for cleaning. Do not use liquid or chemical cleaners.

[d The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the
screen's surface chips or cracks, and do not touch or attempt to remove the broken pieces.

Protecting Your Personal Information

When you give the printer to someone else or dispose of it, erase all the personal information stored in the printer's
memory by selecting Setup > Restore Default Settings > All Settings on the control panel.

13
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Printer Basics

Part Names and Functions

(1 (2] © 0
\_ly

(6]

(1) Edge guide Feeds the paper straight into the printer. Slide to the edges of the paper.

(2] Rear paper feed Loads paper.

(3) Paper support Supports loaded paper.

(4] Feeder guard Prevents foreign substance from entering the printer. Usually keep this guard
closed.

(5) Output tray Holds the ejected paper. Before printing, raise the stopper to prevent the
ejected paper from falling off the tray.

(6) Control panel Operates the printer.
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Memory card slot Insert a memory card.

(2] Ink cartridge holder Install the ink cartridges. Ink is ejected from the print head nozzles underneath.

(1) Document cover Blocks external light while scanning.

(2] Scanner glass Place the originals.

(3] Scanner unit Scans placed originals. Open when replacing ink cartridges or removing
jammed paper inside the printer.

(1) ACinlet Connects the power cord.

(2] USB port Connects a USB cable.
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Control Panel

You can change the angle of the control panel.

To lower the control panel, squeeze the lever on the back of the panel as shown below.

Buttons

o © 6 0 o

l
‘

"
ae
(1) (I) Turns the printer on or off.
Do not turn off while the power light is flashing (while the printer is operating or processing
data).
Unplug the power cord when the power light is off.
(2] ﬂ Displays the home screen.
(3] o) Returns to the previous screen.
o AV 4P oK Use the A ¥ 4P buttons to select a menu, and press the OK button to run the selected menu.
(5] -+ Selects the number of pages to print.
(6] @ Stops the current operation.
(7] @ Starts an operation such as printing or copying.
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Guide to the LCD Screen

Menus and messages are displayed on the LCD screen. Select a menu or setting by pressing the A ¥ 4P buttons.

Guide to the Home Screen

The following icons and menus are displayed on the home screen.

Proceed

(1] Icons that show the network status are displayed. You can learn the meaning of the icons in the Help menu. Enter
Help from the home screen using the € or P> button, and then press the OK button. Select Icon List using the A or
V¥ button, and then press the OK button.

(2] Function icons and names are displayed as mode icons.
Copy Enters Copy mode that allows you to copy a document.
Print Photos Enters Print Photos mode that allows you to print photos on your memory card.
Scan Enters Scan mode that allows you to scan a document or a photo.
More Functions Enters More Functions mode that offers you various printing functions such as copying

photos and printing original ruled paper or calendars using the photos on your memory card.

Quiet Mode Displays Quiet Mode setting that allows you to reduce the noise the printer makes. However,
enabling this may reduce print speed. Depending on the paper type and print quality settings
you selected, there may be no difference in the printer's noise level.

This is a shortcut to the following menu.

Setup > Printer Setup > Quiet Mode

Setup Enters Setup mode that allows you to make maintenance, printer setup, and network settings.

Help Displays help information on basic operations, meaning of the icons displayed on the LCD
screen, and troubleshooting information.

Wi-Fi Setup Displays menus that allow you to set up the printer for use on a wireless network. This is a
shortcut to the following menu.

Setup > Network Settings > Wi-Fi Setup

3] When dand P> are displayed, you can scroll right or left.

(4] Available buttons are displayed. In this example, you can proceed to the selected menu by pressing the OK button.
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Entering Characters

To enter characters and symbols for network settings from the control panel, use the A, ¥, 4, and P> buttons and

the software keyboard on the LCD screen. Press the AY, 4, or P> button to highlight a character or function
button on the keyboard, and then press the OK button to confirm. When you have finished entering characters,
highlight Done, and then press the OK button.

The displayed screen varies depending on the settings items. The following is the screen for entering the password
for your Wi-Fi network.

I- - _— -
ABCDEFGHI J[ABI2[a5I2
KLMNOPQRST © Symbal

< >
-
Space
Done

UVHWXYZ

123456785910

Icons Descriptions
AB12 Changes letters to uppercase.
ab12 Changes letters to lowercase.
Symbol Displays symbols.
4> Moves the cursor to the left or right.

Deletes a character to the left (backspace).

Space Enters a space to the right of the cursor.

Done Closes the software keyboard screen and displays a confirmation screen, or moves to the next screen.
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Network Connection Types

You can use the following connection methods.

Wi-Fi Connection

Connect the printer and the computer or smart device to the access point. This is the typical connection method
for home or office networks where computers are connected by Wi-Fi through the access point.

Gip)

Z

(7

1)
»)

===

Related Information
= “Connecting to a Computer” on page 20
= “Connecting to a Smart Device” on page 21

= “Making Wi-Fi Settings from the Printer” on page 21

Wi-Fi Direct (Simple AP) Connection

Use this connection method when you are not using Wi-Fi at home or at the office, or when you want to connect
the printer and the computer or smart device directly. In this mode, the printer acts as an access point and you can
connect up to four devices to the printer without having to use a standard access point. However, devices directly
connected to the printer cannot communicate with each other through the printer.
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Note:
Wi-Fi Direct (Simple AP) connection is a connection method designed to replace Ad Hoc mode.

(7

)

)

—~ —~
) —~

The printer can be connected by Wi-Fi and Wi-Fi Direct (Simple AP) connection simultaneously. However, if you
start a network connection in Wi-Fi Direct (Simple AP) connection when the printer is connected by Wi-Fi, the
Wi-Fi is temporarily disconnected.

Related Information

= “Making Wi-Fi Direct (Simple AP) Connection Settings” on page 24

Connecting to a Computer

We recommend using the installer to connect the printer to a computer. You can run the installer using one of the
following methods.

[ Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.

http://epson.sn

[ Setting up using the software disc (only for the models that come with a software disc and users with computers
with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.
Selecting the Connection Methods

Follow the on-screen instructions until the following screen is displayed, and then select the connection method of
the printer to the computer.
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Select the connection type and then click Next.

3 irstzl Havi [ 1 [

Start Setup Connecting your
. kicense Agreement WI-Fl Connection
? Eslablishes a wirebkss connechon wilh the E ----- l F:-

_ System Check
USB connection

. instalation :_' Connect the 1o & computer using & USB Q F:q
cabla

Addgional Installation

Finish The compuier is connectad to the wireless netwark
0 You can use the - by selecting [Wi-Fi Connection]

Achvan nfiguraiion

Setup Complate
Cancel Back Mexd

Follow the on-screen instructions.

Connecting to a Smart Device

You can use the printer from a smart device when you connect the printer to the same Wi-Fi network (SSID) as the
smart device. To use the printer from a smart device, set up from the following website. Access to the website from
the smart device that you want to connect to the printer.

http://epson.sn > Setup

Note:
If you want to connect a computer and a smart device to the printer at the same time, we recommend connecting the
computer first.

Making Wi-Fi Settings from the Printer

You can make network settings from the printer's control panel in several ways. Choose the connection method
that matches the environment and conditions that you are using.

If you know the information for the access point such as SSID and password, you can make settings manually.
If the access point supports WPS, you can make settings by using push button setup.

After connecting the printer to the network, connect to the printer from the device that you want to use (computer,
smart device, tablet, and so on.)

Make advanced network settings to use a static IP address.

Related Information
= “Making Wi-Fi Settings Manually” on page 22
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= “Making Wi-Fi Settings by Push Button Setup” on page 23
= “Making Wi-Fi Settings by PIN Code Setup (WPS)” on page 24
= “Making Wi-Fi Direct (Simple AP) Connection Settings” on page 24

= “Making Advanced Network Setting” on page 25

Making Wi-Fi Settings Manually

You can manually set up the information necessary to connect to an access point from the printer's control panel.
To set up manually, you need the SSID and password for an access point.

Note:
If you are using an access point with its default settings, the SSID and password are on the label. If you do not know the SSID
and password, contact the person who set up the access point, or see the documentation provided with the access point.

< B
SsID
< XXXXXXXXXX
o
° ‘ r] ﬁ KEY
° XXXXXXXXXXXXX
o
.

Select Wi-Fi Setup on the home screen, and then press the OK button.
Select Wi-Fi (Recommended), and then press the OK button.

Press the OK button.

Select Wi-Fi Setup Wizard, and then press the OK button.

Select the SSID for the access point from printer's control panel, and then press the OK button.

Note:
(A If the SSID you want to connect to is not displayed on the printer’s control panel, select Search Again to update the
list. If it is still not displayed, select Other SSIDs, and then enter the SSID directly.

1 If you do not know the SSID, check if it is written on the label of the access point. If you are using the access point
with its default settings, use the SSID written on the label.
Enter the password, and then select Done. Press the OK button.

Note:
[d The password is case-sensitive.

[ If you do not know the password, check if it is written on the label of the access point. If you are using the access point
with its default settings, use the password written on the label. The password may also be called a "Key", a
"Passphrase”, and so on.

A If you do not know the password for the access point, see the documentation provided with the access point, or
contact the person who set it up.

Check the settings, and then press the OK button.
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8. Select whether or not you print a network connection report after finishing the settings.

Note:
If you fail to connect, load papers, and then press the D button to print a network connection report.

Related Information

= “Entering Characters” on page 18

= “Checking the Network Connection Status” on page 26
= “When You Cannot Make Network Settings” on page 141

Making Wi-Fi Settings by Push Button Setup

You can automatically set up a Wi-Fi network by pressing a button on the access point. If the following conditions
are met, you can set up by using this method.

[d The access point is compatible with WPS (Wi-Fi Protected Setup).

[d The current Wi-Fi connection was established by pressing a button on the access point.

Note:
If you cannot find the button or you are setting up using the software, see the documentation provided with the access point.

1. Select Wi-Fi Setup on the home screen, and then press the OK button.
2. Select Wi-Fi (Recommended), and then press the OK button.

3. Press the OK button.

4. Select Push Button Setup (WPS), and then press the OK button.

5. Hold down the [WPS] button on the access point until the security light flashes.

If you do not know where the [WPS] button is, or there are no buttons on the access point, see the
documentation provided with your access point for details.

6. Press the OK button on the printer's control panel. Follow the on-screen instruction hereafter.

Note:
If connection fails, restart the access point, move it closer to the printer, and try again. If it still does not work, print a
network connection report and check the solution.
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Related Information

= “Checking the Network Connection Status” on page 26
= “When You Cannot Make Network Settings” on page 141

Making Wi-Fi Settings by PIN Code Setup (WPS)

You can connect to an access point by using a PIN code. You can use this method to set up if an access point is
capable of WPS (Wi-Fi Protected Setup). Use a computer to enter a PIN code into the access point.

1.

Select Setup on the home screen, and then press the OK button.

Select Network Settings and then press the OK button.

Select Wi-Fi Setup on the home screen and then press the OK button.

Select PIN Code Setup (WPS) and then press the OK button.

Use your computer to enter the PIN code (an eight digit number) displayed on the printer's control panel into

the access point within two minutes.

Note:

See the documentation provided with your access point for details on entering a PIN code.
Press the OK button.

Setup is complete when the setup completion message is displayed.

Note:
If connection fails, restart the access point, move it closer to the printer, and try again. If it still does not work, print a
connection report and check the solution.

Related Information

= “Checking the Network Connection Status” on page 26
= “When You Cannot Make Network Settings” on page 141

Making Wi-Fi Direct (Simple AP) Connection Settings

This method allows you to connect the printer directly to computer or smart devices without an access point. The
printer acts as an access point.

g Important:

When you connect from a computer or smart device to the printer using the Wi-Fi Direct (Simple AP) connection,
the printer is connected to the same Wi-Fi network (SSID) as the computer or smart device and the communication
is established between them. Since the computer or smart device is automatically connected to the other connectable
Wi-Fi network if the printer is turned off, it is not connected to the previous Wi-Fi network again if the printer is
turned on. Connect to the printer's SSID for Wi-Fi Direct (Simple AP) connection from the computer or smart
device again. If you do not want to connect every time you turn the printer on or off, we recommend using Wi-Fi
network by connecting the printer to an access point.

1.

Select Wi-Fi Setup on the home screen, and then press the OK button.
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Select Wi-Fi Direct, and then press the OK button.
Press the OK button.

Press the OK button to start the setup.

Press the OK button.

Check the SSID and password displayed on the printer's control panel. On the network connection screen of
the computer or smart device, select the SSID shown on the printer's control panel to connect.

Enter the password displayed on the printer's control panel on the computer or smart device.
After the connection is established, press the OK button on the printer's control panel.

Press the OK button.

Related Information

= “Checking the Network Connection Status” on page 26
= “When You Cannot Make Network Settings” on page 141

Making Advanced Network Setting

You can change the network device name, TCP/IP setup, DNS server and so on. Check your network environment
before making changes.

1.

Select Setup on the home screen, and then press the OK button.
Select Network Settings, and then press the OK button.
Select Manual Network Setup, and then press the OK button.

Enter the device name.

You can enter the following characters. To fix the device name, move the cursor on the Done, and then press
the OK button.

[d Character limits: 2 to 15 (you must enter at least 2 characters)
[ Usable characters: AtoZ,atoz,0to9, -.
(4 Characters you cannot use at the top: 0 to 9, -.

(d Characters you cannot use at the bottom: -

Note:

If you press the OK button without entering the device name, the default device name (EPSON and the last six digits of
the device's MAC address) are set.

Select the method for acquiring the IP address (TCP/IP Setup).

d Auto

Select when you are using an access point at home or you are allowing the IP address to be acquired
automatically by DHCP.
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[ Manual

Select when you do not want the device's IP address to be changed. Enter the IP address, subnet mask,
default gateway, primary DNS server, and secondary DNS server according to your network environment.
Press the OK button, and go to step 7.

Select the method for setting the DNS server.
d Auto

Select when you want to acquire the IP address automatically.

[ Manual

Select when you want to set a unique DNS server address to the device. Enter the addresses for the primary
DNS server and the secondary DNS server.
Select whether or not to use a proxy server.

[ Do Not Use

Select when you are using the printer in a home network environment.

1 Use

Select when you are using a proxy server in your network environment and you want to set it to the printer.
Enter the proxy server address and port number.
Check the settings and press the OK button.

A message is displayed on the LCD screen when the network settings are complete, and you are returned to
the home screen after a short period of time.

Checking the Network Connection Status

You can check the network connection status in the following way.

Checking the Network Status Using Network Icon

You can check the network connection status using the network icon on the printer's home screen. The icon
changes depending on the connection type and strength of the radio wave. For more information, select Help >
Icon List on the printer's control panel.

Checking the Network Status from the Control Panel

You can also view other network-related information by pressing the network menus you want to check.

1.

Select Setup on the home screen, and then press the OK button.
Select Network Settings, and then press the OK button.

Select Network Status, and then press the OK button.

Displays the Wi-Fi and Wi-Fi Direct (Simple AP) connection status. You can check if the printer is connected
to the network, or how many devices are connected when the printer is connected by Wi-Fi Direct (Simple
AP) connection.
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To check other information, press the € or P> button and then select the menus that you want to check.

1 Wi-Fi Status

Displays the network information (Obtain IP Address, Default Gateway, DNS Server Setup Mode and so
on) for Wi-Fi connections.

[ Wi-Fi Direct Status

Displays the network information (Obtain IP Address, the number of connected devices, Default Gateway
and so on) for Wi-Fi Direct (Simple AP) connections.

[d Epson Connect Status
Displays the registered information for Epson Connect services.
d Google Cloud Print Status

Displays the registered information for Google Cloud Print services and the connection status.

[ Print Status Sheet

Make sure that papers are set to the printer, then press the <> button to print a network status sheet.

Printing a Network Connection Report

You can print a network connection report to check the status between the printer and the access point.

1.

Load papers.
Select Setup on the home screen, and then press the OK button.
Select Network Settings, and then press the OK button.

Select Connection Check, and then press the OK button.

The connection check starts.

Select Yes, and then press the OK button.

Press the <> button to print the network connection report.

If an error has occurred, check the network connection report, and then follow the printed solutions.

Related Information

= “Messages and Solutions on the Network Connection Report” on page 28
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Messages and Solutions on the Network Connection Report

Check the messages and error codes on the network connection report, and then follow the solutions.

da

Check Metwork Connection

Check Result

>

Error code

[{E—?]

See the Network Status and check if the Network Name (S5SID) is

the SSID you want to connect.

If the SSID is correct, make sure to enter the correct password

and try again.

If your problems persist

see your documentation for help and networking tips.

Checked Items

Wirelesas Network Name (55ID) Check
Communication Mode Check

Security Mode Check

MAC Address Filtering Check
Security Key/Password Check

IP Address Check

Detailed IP Setup Check

PASS
PASS
PASS
PASS
FAIL
Unchecked
Unchecked

= e
Metwork Status

Printer Model

IP Address

Subnet Mask
Default Gateway
Network Name (SSID)
Communication Mode
Signal Strength
MAC Address

XX-XXX XXX Eeries
0.0.0.0
255.255.255.0

AXXXXXXKKXXX
WEAZ-FPSK (AES)
Poor
44:D02:44:DA:CD:43

a. Error code

b. Messages on the Network Environment

Related Information
= “E-1” on page 29

= “E-2, E-3, E-7” on page 29
= “E-5” on page 30

= “E-6” on page 30

= “E-8” on page 31

= “E-9” on page 31

= “E-10” on page 31
= “E-11” on page 32
= “E-12” on page 32
= “E-13” on page 33

= “Message on the Network Environment” on page 33
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E-1

Message:

Confirm that the network cable is connected and network devices such as hub, router, or access point are turned
on.

Solutions:
[J Make sure the Ethernet cable is securely connected to your printer and to your hub or other network device.
[d Make sure your hub or other network device is turned on.

[ If you want to connect the printer by Wi-Fi, make Wi-Fi settings for the printer again because it is disabled.

E-2,E-3,E-7

Message:

No wireless network names (SSID) found. Confirm that the router/access point is turned on and the wireless
network (SSID) is set up correctly. Contact your network administrator for assistance.

No wireless network names (SSID) found. Confirm that the wireless network name (SSID) of the PC you wish to
connect is set up correctly. Contact your network administrator for assistance.

Entered security key/password does not match the one set for your router/access point. Confirm security key/
password. Contact your network administrator for assistance.

Solutions:

[d Make sure your access point is turned on.

(4 Confirm that your computer or device is connected correctly to the access point.

(4 Turn off the access point. Wait for about 10 seconds, and then turn it on.

[ Place the printer closer to your access point and remove any obstacles between them.

[ If you have entered the SSID manually, check if it is correct. Check the SSID from the Network Status part on
the network connection report.

[ If an access point has multiple SSIDs, select the SSID that is displayed. When the SSID is using a non-compliant
frequency, the printer does not display them.

[ If you are using push button setup to establish a network connection, make sure your access point supports
WPS. You cannot use push button setup if your access point does not support WPS.

[d Makes sure your SSID uses only ASCII characters (alphanumeric characters and symbols). The printer cannot
display an SSID that contains non-ASCII characters.

(4 Makes sure you know your SSID and password before connecting to the access point. If you are using an access
point with its default settings, the SSID and password are located on a label on the access point. If you do not
know your SSID and password, contact the person who set up the access point, or see the documentation
provided with the access point.

[ If you are connecting to an SSID generated from a tethering smart device, check for the SSID and password in
the documentation provided with the smart device.
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[ If your Wi-Fi connection suddenly disconnects, check for the conditions below. If any of these conditions are
applicable, reset your network settings by downloading and running the software from the following website.

http://epson.sn > Setup

[ Another smart device was added to the network using push button setup.

[ The Wi-Fi network was set up using any method other than push button setup.

E-5

Message:

Security mode (e.g. WEP, WPA) does not match the current setting of the printer. Confirm security mode. Contact
your network administrator for assistance.

Solutions:

Make sure the access point's security type is set to one of the following. If it is not, change the security type on the
access point, and then reset the printer's network settings.

[ WEP-64 bit (40 bit)
[ WEP-128 bit (104 bit)
(J WPA PSK (TKIP/AES)"

[J WPA2 PSK (TKIP/AES)”
[ WPA (TKIP/AES)
[ WPA2 (TKIP/AES)

* WPA PSK is also known as WPA Personal. WPA2 PSK is also known as WPA2 Personal.

E-6

Message:

MAC address of your printer may be filtered. Check whether your router/access point has restrictions such as
MAC address filtering. See the documentation of the router/access point or contact your network administrator for
assistance.

Solutions:

[d Check if MAC address filtering is disabled. If it is enabled, register the printer's MAC address so that it is not
filtered. See the documentation provided with the access point for details. You can check the printer's MAC
address from the Network Status part on the network connection report.

[ If your access point is using shared authentication with WEP security, make sure the authentication key and
index are correct.

(1 If the number of connectable devices on the access point is less than the number of network devices that you
want to connect, make settings on the access point to increase the number of connectable devices. See the
documentation provided with the access point to make settings.
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E-8

Message:

Incorrect IP address is assigned to the printer. Confirm IP address setup of the network device (hub, router, or
access point). Contact your network administrator for assistance.

Solutions:
(d Enable DHCP on the access point if the printer’s Obtain IP Address setting is set to Auto.

[ If the printer’s Obtain IP Address setting is set to Manual, the IP address you manually set is invalid due to out
of range (for example: 0.0.0.0). Set a valid IP address from the printer’s control panel or by using Web Config.

E-9

Message:

Confirm the connection and network setup of the PC or other device. Connection using the EpsonNet Setup is
available. Contact your network administrator for assistance.

Solutions:
Check the following.
[ Devices are turned on.

[J You can access the Internet and other computers or network devices on the same network from the devices you
want to connect to the printer.

If still does not connect your printer and network devices after confirming the above, turn off the access point.
Wait for about 10 seconds, and then turn it on. Then reset your network settings by downloading and running the
installer from the following website.

http://epson.sn > Setup

E-10

Message:

Confirm IP address, subnet mask, and default gateway setup. Connection using the EpsonNet Setup is available.
Contact your network administrator for assistance.

Solutions:
Check the following.
[ Other devices on the network are turned on.

[d Network addresses (IP address, subnet mask, and default gateway) are correct if you have set the printer's
Obtain IP Address to Manual.

Reset the network address if they are incorrect. You can check the IP address, subnet mask, and default gateway
from the Network Status part on the network connection report.

If DHCP is enabled, change the printer’s Obtain IP Address setting to Auto. If you want to set the IP address
manually, check the printer's IP address from the Network Status part on the network connection report, and then
select Manual on the network settings screen. Set the subnet mask to [255.255.255.0].
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If still does not connect your printer and network devices, turn off the access point. Wait for about 10 seconds, and
then turn it on.

E-11

Message:

Setup is incomplete. Confirm default gateway setup. Connection using the EpsonNet Setup is available. Contact
your network administrator for assistance.

Solutions:

Check the following.

[d The default gateway address is correct if you set the printer's TCP/IP Setup setting to Manual.
[d The device that is set as the default gateway is turned on.

Set the correct default gateway address. You can check the default gateway address from the Network Status part
on the network connection report.

E-12

Message:

Confirm the following -Entered security key/password is correct -Index of the security key/password is set to the
first number -IP address, subnet mask, or default gateway setup is correct Contact your network administrator for
assistance.

Solutions:
Check the following.
[d Other devices on the network are turned on.

[d The network addresses (IP address, subnet mask, and default gateway) are correct if you are entering them
manually.

[d The network addresses for other devices (subnet mask and default gateway) are the same.

[ The IP address does not conflict with other devices.

If still does not connect your printer and network devices after confirming the above, try the following.
[d Turn off the access point. Wait for about 10 seconds, and then turn it on.

[J Make network settings again using the installer. You can run it from the following website.

http://epson.sn > Setup

[d You can register several passwords on an access point that uses WEP security type. If several passwords are
registered, check if the first registered password is set on the printer.
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E-13

Message:

Confirm the following -Entered security key/password is correct -Index of the security key/password is set to the
first number -Connection and network setup of the PC or other device is correct Contact your network
administrator for assistance.

Solutions:
Check the following.
(4 Network devices such as an access point, hub, and router are turned on.

(4 The TCP/IP Setup for network devices has not been set up manually. (If the printer's TCP/IP Setup is set
automatically while the TCP/IP Setup for other network devices is performed manually, the printer's network
may differ from the network for other devices.)

If it still does not work after checking the above, try the following.
(4 Turn off the access point. Wait for about 10 seconds, and then turn it on.

[d Make network settings on the computer that is on the same network as the printer using the installer. You can
run it from the following website.

http://epson.sn > Setup

[J You can register several passwords on an access point that uses the WEP security type. If several passwords are
registered, check if the first registered password is set on the printer.

Message on the Network Environment

Message Solution

*Multiple network names (SSID) that The same SSID may be set on several access points. Check the settings on the
match your entered network name (SSID) access points, and change the SSID.

have been detected. Confirm network

name (SSID).

The Wi-Fi environment needs to be After moving the printer closer to the access point and removing any
improved. Turn the wireless router off and obstacles between them, turn off the access point. Wait for about 10 seconds,
then turn it on. If the connection does not and then turn it on. If it still does not connect, see the documentation
improve, see the documentation for the supplied with the access point.

wireless router.

*No more devices can be connected. Computer and smart devices that can be connected simultaneously are
Disconnect one of the connected devices if | connected in full in the Wi-Fi Direct (Simple AP) connection. To add another
you want to add another one. computer or smart device, disconnect one of the connected devices first. You

can confirm the number of wireless devices which can be connected
simultaneously and the number of connected devices by checking the
network status sheet or the printer's control panel.

Printing a Network Status Sheet

You can check the detailed network information by printing it.

1. Load papers.
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2. Select Setup on the home screen, and then press the OK button.
3. Select Network Settings, and then press the OK button.

4. Select Network Status, and then press the OK button.
5. Press the € or P> button, then select Print Status Sheet using the A or ¥ button.

6. Press the < button.

The network status sheet is printed.

Replacing or Adding New Access Points

If the SSID changes due to the replacement of an access point, or an access point is added and a new network
environment is established, re-set the Wi-Fi settings.

Related Information

= “Changing the Connection Method to a Computer” on page 34

Changing the Connection Method to a Computer

Using the installer and re-set up in a different connection method.

[ Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.
http://epson.sn

[ Setting up using the software disc (only for the models that come with a software disc and users with computers
with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.

Selecting Change the Connection Methods

Follow the on-screen instructions until the following screen is displayed.
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Select Change or re-set the connection method on the Select Software Installation screen, and then click Next.

I3 install Navi [XXXXSeries] - b
Start Setup Select Software Installation
- License Agreement . O Re-install the essential software
Select this to re-install software and change the

connection settings.
_» System Check

. O Install application software
Instaliation Select this to install additional Epson printing and scanning

applications.

Connection Setting

F~3 ® Change or re-set the connection method
=~
L

Select this if the network environment has changed because

Additional of replacement of the access point or if you want to change
Instalation or re-set the connection method between the and
computer,
Finish
Setup Complete

Disabling Wi-Fi from the Control Panel

When Wi-Fi is disabled, the Wi-Fi connection is disconnected.
1. Select Setup on the home screen.

2. Select Network Settings.

3. Select Wi-Fi Setup.

4. Select Disable Wi-Fi.

5. Check the message, and then select Yes.

Disconnecting Wi-Fi Direct (Simple AP) connection
from the Control Panel

Note:

When Wi-Fi Direct (Simple AP) connection disabled, all computers and smart devices connected to the printer in Wi-Fi
Direct (Simple AP) connection are disconnected. If you want to disconnect a specific device, disconnect from the device
instead of the printer.

1. Select Setup on the home screen.

2. Select Network Settings.
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3. Select Wi-Fi Setup.
4. Select Wi-Fi Direct Setup.
5. Select Disable Wi-Fi Direct.

6. Check the message, and then select Yes.

Restoring the Network Settings from the Control
Panel

You can restore all network settings to their defaults.
1. Select Setup on the home screen.
2. Select Restore Default Settings > Network Settings.

3. Check the message, and then select Yes.
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Loading Paper

Paper Handling Precautions

[d Read the instruction sheets supplied with the paper.

(d Fan and align the edges of the paper before loading. Do not fan or curl photo paper. Doing so may damage the
printable side.

Yo

[ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled
paper may cause paper jams and smears on the printout.

AN

[d Do not use paper that is wavy, torn, cut, folded, damp, too thick, too thin, or paper that has stickers stuck to it.
Using these types of paper causes paper jams and smears on the printout.

[d Fan and align the edges of the envelopes before loading. When the stacked envelopes are puffed up with air,
press them down to flatten them before loading.

e &

[d Do not use envelopes that are curled or folded. Using these envelopes causes paper jams and smears on the
printout.

[d Do not use envelopes with adhesive surfaces on the flaps or window envelopes.

[d Avoid using envelopes that are too thin, as they may curl during printing.

Related Information

= “Printer Specifications” on page 159
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Available Paper and Capacities

Epson recommends using genuine Epson paper to ensure high-quality printouts.

Genuine Epson Paper

Media Name Size Loading Manual 2- Borderless
Capacity Sided Printing Printing
(Sheets)
Epson Bright White Ink Jet A4 80" v -
Paper
Epson Ultra Glossy Photo A4,13x18 cm (5%7 in.), 20 - v
Paper 10x15 cm (46 in.)
Epson Premium Glossy A4, 13x18 cm (5%7 in.), 16:9 20 - v
Photo Paper wide size (102x181 mm),
10%x15 cm (4%6 in.)
Epson Premium Semigloss A4, 10x15 cm (4x6in.) 20 - v
Photo Paper
Epson Photo Paper Glossy A4, 13x18 cm (5%7 in.), 20 - v
10x15 cm (46 in.)
Epson Matte Paper- A4 20 - v
Heavyweight
Epson Photo Quality Ink Jet A4 80 - -
Paper

* For manual 2-sided printing, you can load up to 30 sheets for paper with one side already printed.

Note:

The availability of paper varies by location. For the latest information on paper available in your area, contact Epson

support.

Commercially Available Paper

Media Name Size Loading Capacity Manual 2-Sided Borderless
(Sheets) Printing Printing
Plain paper™! Letter'2, A4, B5™2, A5, A6™2 Up to the line v -
indicated by the

triangle symbol on
the edge guide.”

Legal2

User Defined ™

1

Envelope™

Envelope #10, Envelope DL,
Envelope C6

10

*1  The loading capacity for pre-punched paper is one sheet.

*2  Only printing from computer is available.
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*3

Loading Paper

For manual 2-sided printing, you can load up to 30 sheets for paper with one side already printed.

Related Information

= “Technical Support Web Site” on page 168

L

To obtain optimum printing results, select the paper type that suits the paper.

ist of Paper Types

Media Name

Media Type

Control Panel

Printer Driver, Smart device

Epson Bright White Ink Jet Paper™ Plain paper Plain paper
Epson Ultra Glossy Photo Paper! Ultra Glossy Epson Ultra Glossy
Epson Premium Glossy Photo Paper” Prem. Glossy Epson Premium Glossy

Epson Premium Semigloss Photo Pa-
per’!

Prem. Semigloss

Epson Premium Semigloss

Epson Photo Paper Glossy™ Glossy Photo Paper Glossy
Epson Matte Paper-Heavyweight™! Matte Epson Matte

Epson Photo Quality Ink Jet Paper™! Matte Epson Matte

Plain paper”’ Plain paper Plain paper
Envelope Envelope Envelope

*1

*2

These paper types are compatible with Exif Print and PRINT Image Matching when printed by the printer driver. For more
information, see the documentation that came with the Exif Print or PRINT Image Matching compatible digital camera.

For smart devices, these media types can be selected when printing using Epson iPrint.

Loading Paper in the Rear Paper Feed

1.

Open the feeder guard, extend the paper support, and then tilt it backwards.
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2. Slide the edge guide to the left.

1
——
| |

3. Load paper vertically along the right side of the rear paper feed with the printable side facing up.

n Important:

Do not load more than the maximum number of sheets specified for the paper. For plain papet, do not load
above the line indicated by the triangle symbol on the edge guide.

A Envelopes
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(4 Pre-punched paper

——

029000000000

000000000000
000000000000

¥ ¥

Note:
(A Load a single sheet of paper without binding holes at the top or the bottom.

(A Adjust the print position of your file to avoid printing over the holes.

4. Slide the edge guide to the edge of the paper, and then close the feeder guard.

5. Check the paper size and paper type settings displayed on the control panel. To use the settings, select
Confirm using the A or ¥ button, press the OK button, and then go to step 7. To change the settings, select

Change using the A or ¥ button, press the OK button, and then go to the next step.

g Important:

The paper setting screen is not displayed if the paper is not loaded along the right side of the rear paper feed. An

error occurs when you start printing.
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Note:
[d A message is displayed if the registered paper size and paper type settings differ from the print settings.

Paper in Sheet Feeder

does not match your print
settings,

\OK|Proceed

(A The paper setting screen is not displayed if you have disabled Paper Configuration in the following menus. In this
situation, you cannot print using AirPrint.

Setup > Printer Setup > Paper Source Settings > Paper Configuration

6. On the paper size setting screen, select the paper size using the A or ¥ button, and then press the OK button.
On the paper type setting screen, select the paper type in the same way, and then press the OK button.
Confirm the settings, and then press the OK button.

Note:
You can also display the paper size and paper type settings screen by selecting the following menus.

Setup > Printer Setup > Paper Source Settings > Paper Setup

7. Slide out the output tray and then raise the stopper.

Note:
Return the remaining paper to its package. If you leave it in the printer, the paper may cutl or the print quality may
decline.

Related Information

= “Paper Handling Precautions” on page 37
= “Available Paper and Capacities” on page 38
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Placing Originals

Placing Originals on the Scanner Glass

g Important:

When placing bulky originals such as books, prevent exterior light from shining directly onto the scanner glass.

1. Open the document cover.

—

2. Remove any dust or stains on the scanner glass.

3. Place the original face-down and slide it to the corner mark.

Note:
A range of 1.5 mm from the bottom edge and right edge of the scanner glass is not scanned.

4. Close the cover gently.

n Important:

Do not apply too much force to the scanner glass or the document cover. Otherwise, they may be damaged.

5. Remove the originals after scanning.

Note:
If you leave the originals on the scanner glass for a long time, they may stick to the surface of the glass.

43



User's Guide

Placing Originals

How to Place Various Originals

Placing Photos for Copying

You can place multiple photos at a time to make separate copies. The photos should be larger than 30x40 mm.
Place a photo 5 mm away from the corner mark of the scanner glass, and leave 5 mm between photos. You can
place photos of different sizes at the same time.

Maximum size: 10x15 cm (4x6 in.)

Placing Multiple Photos for Scanning at the Same Time

You can scan multiple photos at the same time and save each image, using Photo Mode in Epson Scan 2. Place the
photos 4.5 mm away from the horizontal and vertical edges of the scanner glass, and place them at least 20 mm
apart from each other. The photos should be larger than 15x15 mm.

Note:
Enable the Thumbnail check box at the top of the preview window.

4.5mm
(0.2")
e Nle—
15mm
(0.6")
20mm
(0.8")
15mm y :
(0.6")
T |
4.5mm
(0.2
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Inserting a Memory Card

Inserting a Memory Card

Supported Memory Cards

£E) - "Ea miniSD”
(€ <::| & Il

miniSDHC*

microSD*
microSDHC”
microSDXC”

SD
SDHC
SDXC

*  Attach an adapter to fit the memory card slot. Otherwise, the card may get stuck.

Related Information

= “Supported Memory Card Specifications” on page 162

Inserting and Removing a Memory Card

1. Inserta memory card into the printer.

The printer starts reading the data and the light flashes. When reading is complete, the light stops flashing and
remains on.

n Important:

[ Insert a memory card straight into the printer.

[ The card should not be fully inserted. Do not try to force it all the way into the slot.
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Inserting a Memory Card

2. When you have finished using the memory card, make sure the light is not flashing, and then remove the card.
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n Important:

If you remove the memory card while the light is flashing, the data in the memory card may be lost.

Note:
If you access the memory card from a computer, you need to operate the computer to safely remove the removable
device.

Related Information

= “Accessing a Memory Card From a Computer” on page 167
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Printing

Printing from the Control Panel

Printing Photos by Selecting from a Memory Card

1.

Load paper in the printer.

g Important:

Make the paper settings on the control panel.

Insert a memory card into the printer.

g Important:

Do not remove the memory card until you have finished printing.

Enter Print Photos from the home screen using the € or P> button, and then press the OK button.

Select a photo using the @ or P> button and set the number of copies using the - or + button. When printing
more than one photo, repeat this procedure.

Note:

The following menus, that are displayed by pressing the ¥ button, help you select photos easily when you have many
photos on your memory card.

(4 Select Photos: use the Select by Date menu to sort photos by date and select all photos of the same date at the same
time.

[ Display Options: use the Thumbnail menu to display nine photos on a screen.

Press the ¥ button to display the menu, select Print Settings using the A or ¥ button, and then press the OK
button.

Note:
Select Crop/Zoom if you want to crop a part of a photo. Use the &, VW, 4, or W button to move the frame to the area

you want to crop, and then press the - or + button to change the size of the frame. Press the M button to rotate the
frame.

Use the A or ¥ button to select setting items such as the paper size and the paper type, and change the
settings using the @ or P> button.

Press the <> button.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

= “List of Paper Types” on page 39
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= “Inserting a Memory Card” on page 45
= “Menu Options for Print Photos Mode” on page 52

Printing Lined Paper, Calendars, Original Writing Paper, and
Original Greeting Cards

You can easily print lined paper, calendars, original writing paper, and original greeting cards using the Personal
Stationery menu.

1. Load paper in the printer.

2. To print writing paper and greeting cards using a photo on your memory card, insert the memory card into
the printer.

3. Enter More Functions from the home screen using the <or P button, and then press the OK button.
4. Select Personal Stationery using the A or ¥ button, and then press the OK button.

5. Select a menu item using the A or ¥ button, and then press the OK button.

Note:
When printing greeting cards, you can add an image stored in the printer instead of using a photo on your memory
card. To add an image stored in the printer, select Template Art.

6. Follow the on-screen instructions to print.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39
= “List of Paper Types” on page 39

= “Inserting a Memory Card” on page 45

= “Menu Options for Printing Lined Paper, Calendars, Original Writing Paper, and Original Greeting Cards” on
page 49
= “Menu Options for Print Photos Mode” on page 52
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Menu Options for Printing Lined Paper, Calendars, Original Writing Paper,
and Original Greeting Cards

Lined Papers:

Prints some types of lined paper, graph paper, or music paper.

Writing Papers:
Prints some types of writing paper with a photo from the memory card set as the background. The

photo is printed lightly so that it can be easily written on.

Calendar:

Prints a weekly or monthly calender. Select the year and the month for the monthly calendar.

Message Card:
Prints a greeting card using images from the printer or images on the memory card.

[d Image Position

Select where you want to place the image on the greeting card.

[ Line Type
Select the type of ruled line to print on the greeting card.

[ Line Color

Select the color of the ruled line to print on the greeting card.

Printing Original Envelopes

You can create original envelopes by adding an image stored in the printer using the Personal Stationery menu.
You can use the same image to print greeting cards that match the envelopes.

First print a diagram of an envelope on A4 size paper, and then fold it to create an envelope.

1. Enter More Functions from the home screen using the € or P> button, and then press the OK button.
2. Select Personal Stationery using the A or ¥ button, and then press the OK button.
3. Select Origami using the A or ¥ button, and then press the OK button.

4. Select Origami Envelope using the A or ¥ button, and then press the OK button.
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Select the image you want to print on the envelopes using the € or P> button, and then press the OK button.

A screen indicating the print position of the image, and whether to print fold lines is displayed.

To change the image position and the fold line setting, press the ¥ button to display the setting screen and
change the settings.

When you have finished making settings, press the 3 button to return to the setting confirmation screen, and
then press the OK button.

Select the size of the envelopes using the € or P> button, and then press the OK button.

Load A4 plain paper in the printer, and then press the OK button.

10. Set the number of copies using the - or + button, and then press the <> button.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

Folding Envelopes

After printing a diagram of an envelope, print an instruction sheet that shows you how to fold the envelope, and
then lay the instruction sheet on top of the diagram and fold them together.

1.

Select Origami Envelope Instruction from the Origami menu, and then press the OK button.

Select the envelope size that you selected to print the envelope diagram using the € and P> button, and then
press the OK button.

Load A4 plain paper in the printer, and then press the OK button.

Set the number of copies using the — or + button, and then press the <> button.

The following instruction sheet is printed.
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5. Lay the instruction sheet on top of the envelope diagram, and then fold them together following the
instructions on the instruction sheet.

6. When finished, unfold them and remove the instruction sheet, and then fold only the envelope diagram again
along its creases.

Printing in Various Layouts

You can print the photos on your memory card in various layouts such as 2-up, 4-up, and upper half.

Note:
While printing with this feature, the printing speed may be slow.

Enter More Functions from the home screen using the € or P> button, and then press the OK button. Select Photo

Layout Sheet using the A or ¥ button, and then press the OK button. Follow the on-screen instructions to print.

Related Information
= “Menu Options for Print Photos Mode” on page 52

Printing from a Slideshow

You can run a slideshow of the photos on your memory card, and then print photos from the slideshow.

8 W
= s
Enter More Functions from the home screen using the  or P button, and then press the OK button. Select Slide

Show using the A or ¥ button, and then press the OK button to run the slideshow. Press the ¥ button to pause
the slideshow, and press it again to restart. To print the photo, press the OK button. The setting menu items are the
same as those shown in the Print Photos mode.

Related Information

= “Printing Photos by Selecting from a Memory Card” on page 47
= “Menu Options for Print Photos Mode” on page 52
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DPOF Printing

This printer is compatible with DPOF (Digital Print Order Format) Ver. 1.10. DPOF is a format that stores
additional information for photos such as the date, time, user name, and printing information. DPOF-compatible
cameras allow you to set which image on a memory card to print and the number of copies. When the memory
card is inserted into the printer, the photos selected by the camera are printed.

Note:
For information on making print settings on your camera, see the documentation provided with your camera.

When you insert a memory card into the printer, a confirmation screen is displayed. Select Yes using the A or ¥
button, and then press the OK button to display the print start screen. Press the <> button to start printing. If you

want to change the print settings, press the ¥ button. Setting items are the same as in Print Photos.

Related Information
= “Printing Photos by Selecting from a Memory Card” on page 47
= “Menu Options for Print Photos Mode” on page 52

Menu Options for Print Photos Mode

Select Photos

[ Select by Date

Displays the photos on the memory card sorted by date. You can print all photos with the same date
at the same time.

[ Cancel Photo Selection

Returns the number of prints of all photos to 0 (zero).

Display Options
(d 1 photo with Info.

Displays one photo on a screen. Information on settings, such as zoom, is also displayed.

(d 1 photo

Displays one photo on a screen. Information on settings, such as zoom, is not displayed.

[ Thumbnail

Displays nine photos on a screen.

Print Settings
[ Paper Size
Select the paper size you loaded.
[ Paper Type
Select the paper type you loaded.
(d Borderless

To print without margins around the edges, select Borderless. The image is enlarged a little to
remove margins from the edges of the paper. To print with margins around the edges, select With
Border.
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1 Quality
Select the print quality. Selecting Best provides higher quality printing, but the printing speed may
be slower.

(d Fix Red-Eye
Fixes red-eye in photos. Corrections are not applied to the original file, only to the printouts.
Depending on the type of photo, parts of the image other than the eyes may be corrected.

Crop/Zoom
Enlarges a part of the photo to be printed.

Select Group

If you have more than 1000 photos on your memory card, photos are automatically divided into groups
containing a maximum of 999 photos. Select a group to display.

Printing from a Computer

Printing Basics - Windows

Note:
(A See the online help for explanations of the setting items. Right-click an item, and then click Help.

(A Operations differ depending on the application. See the application’s help for details.

1. Load paper in the printer.

n Important:

Make the paper settings on the control panel.

I

Open the file you want to print.

3. Select Print or Print Setup from the File menu.

b

Select your printer.
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5.

6.

7.

8.

Printing

Select Preferences or Properties to access the printer driver window.

= Prnting Preferences et

PFellwn More Options  Munbenen o

Printing Presets
AddRemove Presels... Document Size | A4 210 % 207 mem w
= Domument - Fast [Jearderiess Sathngd...
&l pocument - Standard Qualty Orientation @Parrsit  (Olandscaps
ﬁ Document - High Qualty
4T Document - 2p Paper Type e =
"_I Cocument - Fast Grayscals |
'Y Document - Grayscale Quabty Standard W
H Phato - 10 x 15 om Porbrait Color @Cﬁm‘ DE-\!:.'S-:HE
ws Fhato - 10 x 15 om Landscaps
1sdedPrintng | OFF =
Sattigs...
—_— ‘-‘-‘;' Multi-Page aff v Page Order....
= [ Colate
Wi wou [
P e
Quet Mode a5 b
Show Settngs O prink Preview
Jab Asr Lite
Fimsat Defaute Irik L s = g
e | [ e

Make the following settings.
[d Document Size: Select the paper size you loaded in the printer.

[J Borderless: Select to print with no margins around the image.

In borderless printing, the print data is enlarged slightly more than the paper size so that no margins are
printed around the edges of the paper. Click Settings to select the amount of enlargement.

[ Orientation: Select the orientation you set in the application.
[ Paper Type: Select the type of paper you loaded.
1 Quality: Select the print quality.
Selecting High provides higher quality printing, but the printing speed may be slower.

[d Color: Select Grayscale when you want to print in black or shades of gray.

Note:
When printing on envelopes, select Landscape as the Orientation setting.

Click OK to close the printer driver window.

Click Print.

Related Information

= “Available Paper and Capacities” on page 38

= “Loading Paper in the Rear Paper Feed” on page 39

= “Guide to Windows Printer Driver” on page 119

= “List of Paper Types” on page 39
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Printing Basics - Mac OS

Note:

Explanations in the section use TextEdit as an example. Operations and screens differ depending on the application. See the
application’s help for details.

1. Load paper in the printer.

2. Open the file you want to print.

3. Select Print from the File menu or another command to access the print dialog.

If necessary, click Show Details or ¥ to expand the print window.

Printer: EPSON XXXX 7|
Presets: Default Settings ﬂ
Copies: |1
Pages: O All
From: 1 ta: |1
Paper Size: A4 H 210 by 297 mm

Orientation: Ti_ Tae

TextEdit hj

Print header and footer
Rewrap contents to fit page

concel (I

4. Make the following settings.
[ Printer: Select your printer.
[ Presets: Select when you want to use the registered settings.

[ Paper Size: Select the paper size you loaded in the printer.

When printing with no margins, select a "borderless" paper size.

[d Orientation: Select the orientation you set in the application.

Note:
[ If the above setting menus are not displayed, close the print window, select Page Setup from the File menu, and then
make settings.

[d When printing on envelopes, select landscape orientation.
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5.  Select Print Settings from the pop-up menu.

Printer:  EPSON 3000

Presets: Default Settings

(> f o)

Copies: |1
Pages: D Al
From: 1 o 1
Paper Size: A4 B 210by 207 mm

Orientation: | W Te

Print Settings E

Media Type: plain papers

o o

Print Quality: Mormal

Grayscale
Mirror Image

cancel (N

Note:
On OS X Mountain Lion or later, if the Print Settings menu is not displayed, the Epson printer driver has not been
installed correctly.

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the
printer, and then add the printer again. Access the following website, and then enter the product name. Go to Support,
and then see Tips.

http://epson.sn

6. Make the following settings.
[d Media Type: Select the type of paper you loaded.

[ Print Quality: Select the print quality.
Selecting Fine provides higher quality printing, but the printing speed may be slower.

[J Expansion: Available when selecting a borderless paper size.

In borderless printing, the print data is enlarged slightly more than the paper size so that no margins are
printed around the edges of the paper. Select the amount of enlargement.

[J Grayscale: Select to print in black or shades of gray.
7. Click Print.
Related Information

= “Available Paper and Capacities” on page 38
= “Loading Paper in the Rear Paper Feed” on page 39
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= “Guide to Mac OS Printer Driver” on page 122

= “List of Paper Types” on page 39

Printing on 2-Sides (for Windows only)

The printer driver prints automatically separating even pages and odd pages. When the printer has finished
printing the odd pages, flip the paper over following the instructions to print the even pages. You can also print a
booklet that can be created by folding the printout.

9

I
—
/

Note:
(A This feature is not available for borderless printing.

[ If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.

[d Depending on the paper and the data, ink may bleed through to the other side of the paper.

[d If EPSON Status Monitor 3 is disabled, access the printer driver, click Extended Settings on the Maintenance tab, and

then select Enable EPSON Status Monitor 3.

[ 2-sided printing may not be available when the printer is accessed over a network or is used as a shared printer.

1.

Load paper in the printer.
Open the file you want to print.
Access the printer driver window.

Select Manual (Long-edge binding) or Manual (Short-edge binding) from 2-Sided Printing on the Main
tab.

Click Settings, make the appropriate settings, and then click OK.

Note:
To print as a booklet, select Booklet.

Set the other items on the Main and More Options tabs as necessary, and then click OK.

Click Print.

When the first side has finished printing, a pop-up window is displayed on the computer. Follow the on-screen
instructions.
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Related Information

= “Available Paper and Capacities” on page 38

= “Loading Paper in the Rear Paper Feed” on page 39

= “Printing Basics - Windows” on page 53

Printing Several Pages on One Sheet

You can print two or four pages of data on a single sheet of paper.
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Printing Several Pages on One Sheet - Windows

Note:
This feature is not available for borderless printing.

1.

2.

7.

Load paper in the printer.

Open the file you want to print.

Access the printer driver window.

Select 2-Up or 4-Up as the Multi-Page setting on the Main tab.

Click Page Order, make the appropriate settings, and then click OK to close the window.
Set the other items on the Main and More Options tabs as necessary, and then click OK.

Click Print.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

= “Printing Basics - Windows” on page 53
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Printing Several Pages on One Sheet - Mac OS

1.

2.

7.

Load paper in the printer.

Open the file you want to print.

Access the print dialog.

Select Layout from the pop-up menu.

Set the number of pages in Pages per Sheet, the Layout Direction (page order), and Border.
Set the other items as necessary.

Click Print.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

= “Printing Basics - Mac OS” on page 55

Printing to Fit the Paper Size

You can print to fit the paper size you loaded in the printer.

&
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N

Printing to Fit the Paper Size - Windows

Note:
This feature is not available for borderless printing.

1.

Load paper in the printer.
Open the file you want to print.
Access the printer driver window.

Make the following settings on the More Options tab.

[d Document Size: Select the paper size you set in the application.
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5.

6.

Printing

[d Output Paper: Select the paper size you loaded in the printer.

Fit to Page is selected automatically.

Note:
If you want to print a reduced image at the center of the page, select Center.

Set the other items on the Main and More Options tabs as necessary, and then click OK.

Click Print.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

= “Printing Basics - Windows” on page 53

Printing to Fit the Paper Size - Mac OS

1.

Load paper in the printer.

Open the file you want to print.

Access the print dialog.

Select the size of the paper you set in the application as the Paper Size setting.
Select Paper Handling from the pop-up menu.

Select Scale to fit paper size.

Select the paper size you loaded in the printer as the Destination Paper Size setting.
Set the other items as necessary.

Click Print.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

= “Printing Basics - Mac OS” on page 55
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Printing Multiple Files Together (for Windows Only)

Job Arranger Lite allows you to combine several files created by different applications and print them as a single
print job. You can specify the print settings for combined files, such as layout, print order, and orientation.
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1. Load paper in the printer.

2. Open the file you want to print.

3. Access the printer driver window.

4. Select Job Arranger Lite on the Main tab.

5. Click OK to close the printer driver window.

6. Click Print.
The Job Arranger Lite window is displayed and the print job is added to the Print Project.

7. With the Job Arranger Lite window opened, open the file that you want to combine with the current file, and
then repeat steps 3 to 6.

Note:
A If you close the Job Arranger Lite window, the unsaved Print Project is deleted. To print later, select Save from the
File menu.

[ To open a Print Project saved in Job Arranger Lite, click Job Arranger Lite on the printer driver's Maintenance
tab. Next, select Open from the File menu to select the file. The extension of the saved files is "ecl".

8. Select the Layout and Edit menus in Job Arranger Lite to edit the Print Project as necessary. See the help of
Job Arranger Lite for details.

9. Select Print from the File menu.
Related Information

= “Loading Paper in the Rear Paper Feed” on page 39
= “Printing Basics - Windows” on page 53
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Printing One Image on Multiple Sheets to Create a Poster (for
Windows Only)

This feature allows you to print one image on multiple sheets of paper. You can create a larger poster by taping
them together.

»::i

This feature is not available for borderless printing.
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1. Load paper in the printer.

2. Open the file you want to print.

3. Access the printer driver window.

4. Select 2x1 Poster, 2x2 Poster, 3x3 Poster, or 4x4 Poster from Multi-Page on the Main tab.

5. Click Settings, make the appropriate settings, and then click OK.

Note:
Print Cutting Guides allows you to print a cutting guide.

6. Set the other items on the Main and More Options tabs as necessary, and then click OK.
7. Click Print.
Related Information

= “Loading Paper in the Rear Paper Feed” on page 39
= “Printing Basics - Windows” on page 53
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Making Posters Using Overlapping Alignment Marks

Here is an example of how to make a poster when 2x2 Poster is selected, and Overlapping Alignment Marks is
selected in Print Cutting Guides.

sheet1I <:> lsheet2

@
—>

sheet 3 sheet 4

1. Prepare Sheet 1 and Sheet 2. Cut off the margins of Sheet 1 along the vertical blue line through the center of
the top and bottom cross marks.

4 )

8 sheet1 ¥ B  sheet2 K B sheet1 ¥ sheet2 K

\ 4
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2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets
together from the back.
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3. Cut the taped sheets in two along the vertical red line through the alignment markers (this time, the line to the
left of the cross marks).
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4. Tape the sheets together from the back.

= ® =
¥ sheet1 sheet2 K

= X 034

5. Repeat steps 1 to 4 to tape Sheet 3 and Sheet 4 together.

6. Cut off the margins of Sheet 1 and Sheet 2 along the horizontal blue line through the center of the left and right
side cross marks.
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¥ sheet1 sheet2 H
4
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7. Place the edge of Sheet 1 and Sheet 2 on top of Sheet 3 and Sheet 4 and align the cross marks, and then

temporarily tape them together from the back.
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Printing
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¥ sheet1 sheet2 K
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8. Cut the taped sheets in two along the horizontal red line through the alignment markers (this time, the line
above the cross marks).
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9. Tape the sheets together from the back.
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10. Cut off the remaining margins along the outer guide.
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Printing Using Advanced Features

This section introduces a variety of additional layout and printing features available on the printer driver.

Related Information
= “Windows Printer Driver” on page 118
= “Mac OS Printer Driver” on page 121

Adding a Printing Preset to Print Easily

If you create your own preset of frequently used print settings on the printer driver, you can print easily by
selecting the preset from the list.
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Windows

To add your own preset, set items such as the Document Size and Paper Type on the Main or More Options tab,
and then click Add/Remove Presets in Printing Presets.

Note:
To delete an added preset, click Add/Remove Presets, select the preset name you want to delete from the list, and then delete
it.

Mac OS

Access the print dialog. To add your own preset, set items such as the Paper Size and Media Type, and then save
the current settings as the preset in the Presets setting.

Note:
To delete an added preset, click Presets > Show Presets, select the preset name you want to delete from the list, and then
delete it.

Printing a Reduced or Enlarged Document

You can reduce or enlarge the size of a document by a specific percentage.

Windows
Note:

This feature is not available for borderless printing.

Set the Document Size on the More Options tab. Select Reduce/Enlarge Document, Zoom to, and then enter a
percentage.

Mac OS
Note:
Operations differ depending on the application. See the application’s help for details.

Select Page Setup (or Print) from the File menu. Select the printer from Format For, select the paper size, and
then enter a percentage in Scale. Close the window, and then print following the basic printing instructions.

Adjusting the Print Color

You can adjust the colors used in the print job.

PhotoEnhance produces sharper images and more vivid colors by automatically adjusting the contrast, saturation,
and brightness of the original image data.

Note:
(A These adjustments are not applied to the original data.

[d PhotoEnhance adjusts the color by analyzing the location of the subject. Therefore, if you have changed the location of
the subject by reducing, enlarging, cropping, or rotating the image, the color may change unexpectedly. Selecting the
borderless setting also changes the location of the subject resulting in changes in color. If the image is out of focus, the tone
may be unnatural. If the color is changed or becomes unnatural, print in a mode other than PhotoEnhance.

Windows

Select the method of color correction from Color Correction on the More Options tab.
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If you select Automatic, the colors are automatically adjusted to match the paper type and print quality settings. If
you select Custom and click Advanced, you can make your own settings.

Mac OS

Access the print dialog. Select Color Matching from the pop-up menu, and then select EPSON Color Controls.
Select Color Options from the pop-up menu, and then select one of the available options. Click the arrow next to
Advanced Settings and make the appropriate settings.

Printing a Watermark (for Windows Only)

You can print a watermark such as "Confidential" on your printouts. You can also add your own watermark.

Note:
This feature is not available with borderless printing.

Click Watermark Features on the More Options tab, and then select a watermark. Click Settings to change details
such as the density and position of the watermark.

Printing a Header and Footer (for Windows Only)

You can print information such as a user name and printing date as headers or footers.

Click Watermark Features in the More Options tab, and then select Header/Footer. Click Settings and select
necessary items from the drop-down list.

Printing Photos Using Epson Easy Photo Print
Epson Easy Photo Print lets you lay out and print photos easily on various types of paper. See the application's help
for details.

Note:
[d By printing on genuine Epson photo paper, the ink quality is maximized and the printouts are vivid and clear.

[ To perform borderless printing using a commercially available application, make the following settings.

J Create the image data to fully fit the paper size and if a margin setting is available in the application you are
using, set the margin to 0 mm.

(J Enable the borderless printing setting in the printer driver.
Related Information

= “Epson Easy Photo Print” on page 125
= “Installing Applications” on page 129
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Printing from Smart Devices

Using Epson iPrint
Epson iPrint is an application that allows you to print photos, documents, and web pages from a smart device such
as a smartphone or tablet. You can use local print, printing from a smart device that is connected to the same

wireless network as your printer, or remote print, printing from a remote location over the Internet. To use remote
print, register your printer in the Epson Connect service.

=
EPSON

Related Information

= “Epson Connect Service” on page 116

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/a

Printing Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen.
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The following screens are subject to change without notice. The contents may vary depending on the product.

1 2]

seese 7 19:41 2% | seens & 19:41 2% -

Epson iPrint @ £ Home Photos '— e

35x5in/89x 127 mm

Camera
Capture

femesy S50

Creative Print | More Apps

Documet Cloud

Deselect Rotate E'- e

(1) Home screen displayed when the application is started.

(2] Displays information on how to setup the printer and a FAQ.

(3) Displays the screen where you can select the printer and make printer settings. Once you have selected the
printer, you do not need to select it again from the next time.

(4] Select what you want to print such as photos and documents.

(5] Displays the screen to make print settings such as paper size and paper type.

(6] Displays the paper size. When this is displayed as a button, press it to display the paper settings currently
set on the printer.

(7] Displays photos and documents you selected.

(3] Starts printing.

Note:
To print from the document menu using iPhone, iPad, and iPod touch running iOS, start Epson iPrint after transferring the
document you want to print using the file sharing function in iTunes.
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Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of iOS, and
Mac with the latest version of OS X or macOS.

AirPrint

Note:
If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to
enable the messages, if necessary.

1. Load paper in your product.

2. Set up your product for wireless printing. See the link below.

http://epson.sn
3. Connect your Apple device to the same wireless network that your product is using.

4. Print from your device to your product.

Note:
For details, see the AirPrint page on the Apple website.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

Canceling Printing

Note:
A In Windows, you cannot cancel a print job from the computer once it has been completely sent to the printer. In this case,
cancel the print job by using the printer's control panel.

(A When printing several pages from Mac OS, you cannot cancel all of the jobs by using the control panel. In this case, cancel
the print job from the computer.

[ Ifyou have sent a print job from Mac OS X v10.6.8 through the network, you may not be able to cancel printing from the
computer. In this case, cancel the print job by using the printer’s control panel.

Canceling Printing - Printer Button

Press the @ button to cancel the print job in progress.
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Canceling Printing - Windows

1. Access the printer driver window.

2. Select the Maintenance tab.

3. Click Print Queue.

4. Right-click on the job you want to cancel and then select Cancel.

Related Information

= “Windows Printer Driver” on page 118

Canceling Printing - Mac OS
1. Click the printer icon in the Dock.
2. Select the job you want to cancel.

3. Cancel the job.
[ OS X Mountain Lion or later

Click next to the progress meter.

[ Mac OS X v10.6.8 to v10.7.x
Click Delete.
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Copying Basics

1.

Load paper in the printer.

n Important:

Make the paper settings on the control panel.

Place the originals.

Enter Copy from the home screen using the € or P> button, and then press the OK button.

Set the number of copies using the — or + button.
Select color copy or monochrome copy using the € or P> button.

Select Print Settings using the ¥ button, and then press the OK button. Check the settings such as the paper
size and the paper type and change settings if necessary. Select the setting items using the A or ¥ button and
change settings using the € or P> button.

Note:

If you want to copy by reducing or enlarging the size of a document by a specific percentage, select Custom Size as the
Reduce/Enlarge setting and press the OK button. Then specify a percentage using the — or + button. You can change the
percentage in increments of 10% by holding down the - or + button.

Press the < button.

Note:
The color, size, and border of the copied image are slightly different from the original.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

= “Placing Originals on the Scanner Glass” on page 43

= “Menu Options for Copy Mode” on page 75

Menu Options for Copy Mode

Note:
Available menus vary depending on the layout you selected.

The number of copies

Enter the number of copies.

Color

Copies the original in color.
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B&W

Copies the original in black and white (monochrome).

Density

Increase the level of density by pressing the P> button when the copying results are faint. Decrease the

level of density by pressing the  button when ink smears.

Layout
(d With Border
Copies with margins around the edges.
[J Borderless

Copies without margins around the edges. The image is enlarged a little to remove margins from the
edges of the paper.

1 A4, 2-up Copy
Copies two A4 single-sided originals onto a single sheet of A4 size paper in 2-up layout.
4 A4, Book/2-up

Copies two A4 facing pages of a book and so on onto a single sheet of A4 size paper in 2-up layout.

Reduce/Enlarge
Enlarges or reduces the originals.
(d Actual Size
Copies at 100 % magnification.
[ Auto Fit Page

Detects the scan area and automatically enlarges or reduces the original to fit to the paper size you
selected. When there are white margins around the original, the white margins from the corner
mark of the scanner glass are detected as the scan area, but the margins at the opposite side may be
cropped.

Sy,

: i Hello!

J 10x 15 cm->A4, A4->10 x 15 cm, and others

Automatically enlarges or reduces the original to fit to a specific paper size.

[ Custom Size

Specifies the magnification used to enlarge or reduce the original within a range of 25 to 400%.
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Paper Size

Select the paper size you loaded.

Paper Type
Select the paper type you loaded.

Quality

Select the print quality. Draft provides faster printing, but the printouts may be faint. Best provides
higher quality printing, but the printing speed may be slower.

For users in Western Europe, the draft mode is not available.

Copying Photos

You can copy multiple photos at the same time. You can also restore the colors in faded photos.

Note:
(A The smallest size of original you can copy is 30 x 40 mm.

[ The white space around the photo may not be detected.

1.

Load paper in the printer.

n Important:

Make the paper settings on the control panel.

Enter More Functions from the home screen using the € or P> button, and then press the OK button.

Select Copy/Restore Photos using the A or ¥ button, and then press the OK button.
Select whether or not to restore the colors in faded photos.

Check the screen and place the photos on the scanner glass.

Press the < button.

The photos are scanned and displayed on the screen.

Press the ¥ button, select Print Settings using the A or ¥ button, and then press the OK button. Check the
settings such as the paper size and the paper type and change settings if necessary. Select the setting items

using the A or ¥ button and change the settings using the € or P> button.

Note:
If you want to print by enlarging part of a photo, select Crop/Zoom. Move the frame of the print area using the &, V¥,
A or W button and change the frame size using the - or + button.

Press the < button.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39
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= “Placing Photos for Copying” on page 44
= “Menu Options for Copy/Restore Photos” on page 78

Menu Options for Copy/Restore Photos

Color Restoration

Restores the color of faded photos.

Display Options
(d 1 photo with Info.

Displays one photo on a screen. Information on settings, such as zoom, is also displayed.

A 1 photo
Displays one photo on a screen. Information on settings, such as zoom, is not displayed.

Print Settings
[ Paper Size
Select the paper size you loaded.
[ Paper Type
Select the paper type you loaded.
[d Borderless

To print without margins around the edges, select Borderless. The image is enlarged a little to
remove margins from the edges of the paper. To print with margins around the edges, select With
Border.

1 Quality

Select the print quality. Selecting Best provides higher quality printing, but the printing speed may
be slower.

Crop/Zoom
Enlarges a part of the photo to be printed.
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Scanning Using the Control Panel

Scanning to a Memory Card

You can save the scanned image to a memory card.
1. Place the originals.

2. Inserta memory card into the printer.
3. Enter Scan from the home screen using the € or P> button, and then press the OK button.
4. Select Scan to Memory Card using the  or P button, and then press the OK button.

5. Check settings such as the save format, and change them if necessary. Select the setting items using the A or

WV button and change settings using the € or P> button.

6. Press the < button.

Note:
The color, size, and border of the scanned image will not be exactly the same as the original.

Related Information

= “Placing Originals on the Scanner Glass” on page 43
= “Inserting a Memory Card” on page 45

= “Menu Options for Scanning” on page 83

Scanning to the Cloud
You can send scanned images to cloud services using the Scan to Cloud feature. You can also send the scanned

images by email. Before using this feature, make settings using Epson Connect. See the following Epson Connect
portal website for details.

https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

1. Make sure that you have made settings using Epson Connect.

You need to register destinations to the destination list on the user page.

2. Place the originals.

3. Enter Scan from the home screen using the € or P> button, and then press the OK button.
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4. Select Scan to Cloud using the € or P button, and then press the OK button.
5. Select the destination using the A or ¥ button, and then press the OK button.

6. Check settings such as the save format, and change them if necessary. Select the setting items using the A or

WV button and change settings using the € or P> button.

7. Press the < button.

Note:
The color, size, and border of the scanned image will not be exactly the same as the original.

Related Information
= “Placing Originals on the Scanner Glass” on page 43
= “Menu Options for Scanning” on page 83

Scanning to a Computer

You can save the scanned image to a computer.

g Important:

Make sure you have installed Epson Scan 2 and Epson Event Manager on your computer before using this feature.

1. Place the originals.
2. Enter Scan from the home screen using the or P button, and then press the OK button.

3. Select how to save the scanned image to a computer from the following menus using the € or P> button, and
then press the OK button.

[d Scan to Computer (JPEG): Saves the scanned image in JPEG format.
(d Scan to Computer (PDF): Saves the scanned image in PDF format.

(d Scan to Computer (Email): Starts the email client on your computer, and then automatically attaches it to
an email.

4. Select the computer to which you want to save the scanned images.

Note:
[d You can change the scan settings such as the scanning size, folder to save, or save format, by using Epson Event
Manager.

[ When the printer is connected to a network, you can select the computer to which you want to save the scanned
image. Up to 20 computers can be displayed on the printer's control panel.

[ When the computer to which you want to save the scanned images is detected on the network, the initial 15
characters of the computer name are displayed on the control panel. If you set Network Scan Name
(Alphanumeric) on Epson Event Manager, it is displayed on the control panel.
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5. Press the <> button.

Note:
The color, size, and border of the scanned image will not be exactly the same as the original.

Related Information
= “Placing Originals on the Scanner Glass” on page 43
= “Epson Event Manager” on page 125

Scanning to a Computer (WSD)

Note:
(A This feature is only available for computers running English version of Windows 10/ Windows 8.1/ Windows 8/ Windows 7/
Windows Vista.

3 If you are using Windows 7/ Windows Vista, you need to setup your computer in advance using this feature.

1. Place the originals.
2. Enter Scan from the home screen using the € or P> button, and then press the OK button.

3. Select Scan to Computer (WSD) using the < or P button, and then press the OK button.

4. Select a computer.

5. Press the < button.

Note:
The color, size, and border of the scanned image will not be exactly the same as the original.

Related Information

= “Placing Originals on the Scanner Glass” on page 43

Setting Up a WSD Port

This section explains how to set up a WSD port for Windows 7/Windows Vista.

Note:
For Windows 10/Windows 8.1/Windows 8, the WSD port is set up automatically.

The following is necessary to set up a WSD port.
[d The printer and the computer are connected to the network.

(4 The printer driver is installed on the computer.
1. Turn the printer on.
2. Click start, and then click Network on the computer.

3. Right-click the printer, and then click Install.

Click Continue when the User Account Control screen is displayed.
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Click Uninstall and start again if the Uninstall screen is displayed.

vr‘ » Network » = |“f” Search Network |

Organize »  Install  Search Active Directory  Network and Sharing Center  Add a printer  » g 0 @
=TT TUrNC O T L C v ICC S (I T __{'

I Favorites i

B Desktop g e

8 Downloads

" Recent Places 4 Other Devices (1)
G Libraries d’ s

¥ Documents :

o' Music 4 Printers (5)

=l Pictures

=
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&L Local Disk (C) =

a Local Disk (D:)
‘ : H g
€ Network
— | VICW OCVILE WEopagc
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o i - sl BS Cresteshortcut B
4 EPSONM “4f e 4% Categories: Printers Properties
d Network location: g sl
Note:

The printer name you set on the network and model name (EPSON XXXXXX (XX-XXXX)) are displayed on the
network screen. You can check the printer's name set on the network from the printer's control panel or by printing a
network status sheet.

4. Click Your device is ready to use.

l "ML Your device is ready to use % |

o~

=l (. 12:00 PM

5. Check the message, and then click Close.

Four device i5 ready o use

WED Scan Dwvica wf Rady b2 uin
WD Primk D wof Ready bz e
EPSO0 NE-ITK Series of ey tn e

6. Open the Devices and Printers screen.
[ Windows 7

Click start > Control Panel > Hardware and Sound (or Hardware) > Devices and Printers.
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[ Windows Vista

Click start > Control Panel > Hardware and Sound > Printers.

7. Check that an icon with the printer's name on the network is displayed.

Select the printer name when using with WSD.

Related Information

= “Printing a Network Status Sheet” on page 33

Menu Options for Scanning

The following options are available on the Scan to Memory Card menu and Scan to Cloud menu.

Format

Select the format in which to save the scanned image.

Color

Select whether to scan in color or in monochrome.

Scan Area
Select the scan area. To crop the white space around the text or image when scanning, select Auto
Cropping. To scan at the maximum area of the scanner glass, select Max Area. Select this setting and
scan again if the edges of the scanned image are cropped when A4 is selected.

Document

Select the type of your original.

Resolution
Select the scanning resolution.

This item is only available from Scan to Memory Card.

Contrast

Select the contrast of the scanned image. Increase the level of contrast by pressing the P> button and

decrease by pressing the @ button.

Document Orientation

Select the orientation of your original.

Scanning from a Computer

Scanning Using Epson Scan 2

You can scan by using the scanner driver "Epson Scan 2". See the Epson Scan 2 help for an explanation of each
setting item.
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Related Information

= “Epson Scan 2 (Scanner Driver)” on page 124

Scanning Documents (Document Mode)

Using Document Mode in Epson Scan 2, you can scan originals using detailed settings that are suitable for text
documents.

1. Place the originals.
2. Start Epson Scan 2.
3. Select Document Mode from the Mode list.

4. Make the following settings on the Main Settings tab.

& Epson Scan 2 - O >
Scanner : | EPSON 3000¢K ]
Scan Settings : | Mot Selected \/|
Mode : | Document Mode v|

Main Settings Advanced Settings

Document Size : | A4 v
Image Type : | Color v|
Resolution : 200 ~ | dpi
Rotate : | U~ ¥
Correct Document Skew : | off v|

|:|Add or edit pages after scanning

Image Format : | PDF V|
File Name : [ imgyyYYMMDD_HHMMSSSS.pdf ~]
Folder : | Documents V|

e o Preview Scan

(4 Document Size: Select the size of the original you placed.

a é / IE (Original orientation) buttons: Select the set orientation of the original you placed.
Depending on the size of the original, this item may be set automatically and cannot be changed.

(J Image Type: Select the color for saving the scanned image.

[ Resolution: Select the resolution.

84



User's Guide

Scanning

Note:
[ The Document Source setting is fixed as Scanner Glass. You cannot change this setting.

1 If you set Add or edit pages after scanning, you can scan additional originals after scanning the original. In
addition, if you set the Image Format as PDF or Multi-TIFF, you can save the scanned images as one file.
5. Make other scan settings if necessary.

[d You can preview the scanned image by clicking the Preview button. The preview window opens, and the
previewed image is displayed.

[d On the Advanced Settings tab, you can make detailed image adjustment settings that are suitable for text
documents, such as the following.

[ Remove Background: Remove the background of the originals.
(d Text Enhancement: You can make blurred letters in the original clear and sharp.

(J Auto Area Segmentation: You can make letters clear and images smooth when performing black and
white scanning for a document that contains images.

(J Color Enhance: You can enhance the color specified for the scanned image, and then save it in grayscale
or black and white.

(J Brightness: You can adjust the brightness for the scanned image.

(J Contrast: You can adjust the contrast for the scanned image.

[ Gamma: You can adjust the gamma (brightness of the intermediate range) for the scanned image.
(J Threshold: You can adjust the border for monochrome binary (black and white).

(J Unsharp Mask: You can enhance and sharpen the outlines of the image.

[J Descreening: You can remove moiré patterns (web-like shadows) that appear when scanning printed
papers such as a magazine.

(J Edge Fill: You can remove the shadow created around the scanned image.

(d Dual Image Output (Windows Only): You can scan once and save two images with different output
settings at the same time.

Note:
The items may not be available depending on other settings you made.
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6. Set the file saving settings.

[& Epson Scan 2 - O >
Scanner : | EPSON 3000CK v]
Scan Settings * | Not Selected v|
Mode : | Document Mode v|

Main Settings Advanced Settings

Document Source : | Scanner Glass V|
Document Size : |A4 ~
Tmage Type : | Calor v]
Resolution : | 200 ~ | dpi
Rotate : | 0° v
Correct Document Skew : | off v|

[JAdd or edit pages after scanning

Image Format : | FDF

File Name : | imgyyyyMMDD_HHMMSSSS. pdf |

Folder : | Documents V|

o=

(d Image Format: Select the save format from the list.

You can make detailed settings for each save format except BITMAP and PNG. Select Options from the list
after selecting the save format.

[ File Name: Confirm the save file name displayed.
You can change settings for the file name by selecting Settings from the list.
[ Folder: Select the save folder for the scanned image from the list.

You can select another folder or create a new folder by selecting Select from the list.

7. Click Scan.

Related Information

= “Placing Originals on the Scanner Glass” on page 43

Scanning Photos or Pictures (Photo Mode)

Using Photo Mode in Epson Scan 2, you can scan originals with wide variety of image adjustment features that are
suitable for photos or pictures.

1. Place the originals.

By placing multiple originals on the scanner glass, you can scan them all at the same time. Make sure there is a
gap of at least 20 mm between the originals.
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2. Start Epson Scan 2.
3. Select Photo Mode from the Mode list.

4. Make the following settings on the Main Settings tab.

[& Epson Scan 2 - O >
Scanner : | EPSON 3000CK v
Scan Settings : | Not Selected v|
Mode : | Photo Mode v|

Main Settings Advanced Settings

Document Source : ‘ Scanner Glass v|

Document Tvoe : | Reflective |

Image Type : ‘ Color v|
Resolution : |300 ~ | dpi

Color Management...

Thumbnail Options...

Image Format : | FDF

File Name : |ingYYYMMDD_HHMMSSSS.pdf V|

Folder : | Documents V|

e a Preview Scan

[J Image Type: Select the color for saving the scanned image.
[d Resolution: Select the resolution.
Note:

The Document Source setting is fixed as Scanner Glass, and the Document Type setting is fixed as Reflective.

(Reflective means originals which are not transparent, for example ordinary papers or photos.) You cannot change these
settings.
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5. Click Preview.

The preview window opens, and the previewed images are displayed as thumbnails.

& Epson Scan 2 - O X

Scanner : | EPSON 30000¢

Sean Settings : | Not Selected

Mode : ‘ Photo Made

Main Settings Advanced Settings

Document Source : | Scanner Glass ~]

Document Type : | Reflective ~ |

Image Type : | Color vl
Resolution : |300 ~| dpi

Thumbnail Options...

Image Format : ‘ BDE

File Name : [ imgyYYMMDD_HHMMSSSS. pdf

Folder : [ pocuments

eo Preview ]‘ Scan

Note:
To preview the entire scanned area, clear the Thumbnail check box at the top of the preview widow.

6. Confirm the preview, and make image adjustment settings on the Advanced Settings tab if necessary.

B Epson Scan 2 - O X

Scanner : | EPSON 30000¢

Scan Settings : | Not Selected

Brightness : ‘ 1 U Cl
Contrast : . I O

Saturation : . I 0 l:l

Unsharp Mask : | off v‘

Color Restoration : | off v‘

Backlight Correction : | off v‘

Descreening : |Dﬂ’ v‘

Dust Removal | off v‘

g e pUE

File Name : - [imgyyyyMMDD_HHMMSSSS. pdf

Folder : [ pocuments

2. == e
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You can adjust the scanned image using detailed settings that are suitable for photos or pictures, such as the
following.

[ Brightness: You can adjust the brightness for the scanned image.

[d Contrast: You can adjust the contrast for the scanned image.

[ Saturation: You can adjust the saturation (color vividness) for the scanned image.

[J Unsharp Mask: You can enhance and sharpen the outlines of the scanned image.

[d Color Restoration: You can correct images that have faded to return them to their original colors.
[J Backlight Correction: You can lighten scanned images that are dark due to backlight.

[d Descreening: You can remove moiré patterns (web-like shadows) that appear when scanning printed papers
such as a magazine.

(d Dust Removal: You can remove dust on the scanned image.

Note:
(A The items may not be available depending on other settings you made.

(A Depending on the original, the scanned image may not be adjusted correctly.
(A When multiple thumbnails are created, you can adjust the image quality for each thumbnail. Depending on the

adjustment items, you can adjust the quality of scanned images all together by selecting multiple thumbnails.

7. Set the file saving settings.

& Epson Scan 2 - O x

Scanner : | EPSON 30000C

Scan Settings : | Not Selected

Mode : | Photo Mode

Main Settings Advanced Settings

Brightness : :‘f I :Cf* l:|
Contrast . I O l:|
Saturation : . I 0 l:|

Unsharp Mask : ‘ off V|

Color Restoration : | Off “]

Backlight Correction : ‘ off vl

Descreening : ‘ off V|

Dust Removal : ‘ off V|

Image Format : ‘ EDE

File Name : \umgWWMMDD,HHMMssss.pdf

Folder : ‘ Documents

LT R [ | - Scan Count : 2

[J Image Format: Select the save format from the list.

You can make detailed settings for each save format except BITMAP and PNG. Select Options from the list
after selecting the save format.

[ File Name: Confirm the save file name displayed.

You can change settings for the file name by selecting Settings from the list.
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[ Folder: Select the save folder for the scanned image from the list.

You can select another folder or create a new folder by selecting Select from the list.
8. Click Scan.
Related Information

= “Placing Originals on the Scanner Glass” on page 43
= “Placing Multiple Photos for Scanning at the Same Time” on page 44

Scanning from Smart Devices

Epson iPrint is an application that allows you to scan photos and documents from a smart device, such as a
smartphone or tablet, that is connected to the same wireless network as your printer. You can save the scanned
data on a smart device or to Cloud services, send it by email, or print it.

[ -
-E-

EPSON

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/a

Scanning Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen.
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The following screens are subject to change without notice.

Documet Cloud

7 19:41

Epson iPrint

Place an image/documant, and then press the scan
button —

Camera
Capture

Copy Memory Card

g

Creative Print | More Apps

1]
© 00

Home screen displayed when the application is started.

®

Displays information on how to setup the printer and a FAQ.

<]

Displays the screen where you can select the printer and make printer settings. Once you have selected the
printer, you do not need to select it again from the next time.

Displays the scanning screen.

Displays the screen where you can make scan settings such as resolution.

Displays scanned images.

Starts scanning.

Displays the screen where you can save scanned data to a smart device or Cloud services.

Displays the screen where you can send scanned data by email.

e 06 0 o0 | 6 o

Displays the screen where you can print scanned data.
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Replacing Ink Cartridges

Checking the Ink Levels

You can check the approximate ink levels from the control panel or the computer.

Checking the Ink Levels - Control Panel
1. Enter Setup from the home screen using the  or P button, and then press the OK button.

2. Select Ink Levels using the A or V button, and then press the OK button.

Checking the Ink Levels - Windows
1. Access the printer driver window.

2. Click Ink Levels on the Main tab.

Note:
If EPSON Status Monitor 3 is disabled, the ink levels are not displayed. Click Extended Settings on the Maintenance
tab, and then select Enable EPSON Status Monitor 3.

Related Information

= “Windows Printer Driver” on page 118

Checking the Ink Levels - Mac OS

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

Ink Cartridge Codes

Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epsons warranties, and
under certain circumstances, may cause erratic printer behavior. Information about non-genuine ink levels may

not be displayed.

The following are the codes for genuine Epson ink cartridges.
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Icon BK: Black C: Cyan M: Magenta Y: Yellow
Strawberry 29 29 29 29
20XL" 29XL" 20XL" 29XL"

* "XL" indicates a large cartridge.

Note:
(A Not all cartridges are available in all regions.

(A Ink cartridge codes may vary by location. For the correct codes in your area, contact Epson support.

(A For users in Europe, visit the following website for information on Epson's ink cartridge yields.

http://www.epson.eu/pageyield

Related Information
= “Technical Support Web Site” on page 168

Ink Cartridge Handling Precautions

Read the following instructions before replacing ink cartridges.

Handling precautions

[ Store ink cartridges at normal room temperature and keep them away from direct sunlight.
(4 Epson recommends using the ink cartridge before the date printed on the package.

[ For best results, use up ink cartridge within six months of opening the package.

[ For best results, store ink cartridge packages with their bottom down.

[ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at
least three hours before using it.

(d Do not open the ink cartridge package until you are ready to install it in the printer. The cartridge is vacuum
packed to maintain its reliability. If you leave a cartridge unpacked for a long time before using it, normal
printing may not be possible.

[J Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.
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[J You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may decline or
you may not be able to print. Do not remove or tear the label on the cartridge; this can cause leakage.

[d Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become
unusable.

d Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.

[ Install all ink cartridges; otherwise you cannot print.

[J Do not replace ink cartridges with the power off. Do not move the print head by hand; otherwise, you may
damage the printer.

4 Do not turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.
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(d Do not leave the printer with the ink cartridges removed or do not turn off the printer during cartridge
replacement. Otherwise, ink remaining in the print head nozzles will dry out and you may not be able to print.

[ If you need to remove an ink cartridge temporarily, make sure you protect the ink supply area from dirt and
dust. Store the ink cartridge in the same environment as the printer, with the ink supply port facing down or
sideways. Do not store ink cartridges with the ink supply port facing up. Because the ink supply port is
equipped with a valve designed to contain the release of excess ink, there is no need to supply your own covers
or plugs.

[d Removed ink cartridges may have ink around the ink supply port, so be careful not to get any ink on the

surrounding area when removing the cartridges.

(1 This printer uses ink cartridges equipped with a green chip that monitors information such as the amount of
remaining ink for each cartridge. This means that even if the cartridge is removed from the printer before it is
expended, you can still use the cartridge after reinserting it back into the printer. However, when reinserting a
cartridge, some ink may be consumed to guarantee printer performance.

[J For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. Ink cartridges with
low ink status may not be used when reinserted.

[d To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the cartridge when your printer indicates to replace the cartridge. The yields quoted for you do not
include this reserve.

(4 Although the ink cartridges may contain recycled materials, this does not affect printer function or
performance.

[d Specifications and appearance of the ink cartridge are subject to change without prior notice for improvement.
(d Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.
[d You cannot use the cartridges that came with the printer for the replacement.

(d Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

Ink consumption

(d To maintain optimum print head performance, some ink is consumed from all cartridges during maintenance
operations such as print head cleaning. Ink may also be consumed when you turn on the printer.

[ When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the
paper type or print quality settings. This is because a mixture of color inks is used to create black.

(d The ink in the ink cartridges supplied with your printer is partly used during initial setup. In order to produce
high quality printouts, the print head in your printer will be fully charged with ink. This one-off process
consumes a quantity of ink and therefore these cartridges may print fewer pages compared to subsequent ink
cartridges.

Replacing Ink Cartridges

A Caution:

Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be injured.
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Note:
(A You can continue printing even after the printer indicates that the ink is low. However, prepare new ink cartridges as soon

as possible.

Q If you replace the ink cartridges while copying, the originals may move out of place. Press the & button to cancel and
replace the originals.

1. Do one of the following.
([ When prompted to replace ink cartridges
Check which ink cartridge needs to be replaced, and then press the OK button. Select Replace now using
the A or ¥ button, and then press the OK button.

[ When replacing ink cartridges before they are expended
Enter Setup from the home screen using the  or P button, and then press the OK button. Select
Maintenance using the A or ¥ button, and then press the OK button. Select Ink Cartridge Replacement
using the A or ¥ button, and then press the OK button. Next, press the <> button.
2. When replacing the black ink cartridge, gently shake the new black ink cartridge four or five times and then

remove it from its package. When replacing other color cartridges, remove the new color cartridges from their
package without shaking.

g Important:

Do not shake cartridges after opening the package, as they may leak.
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3. Remove only the yellow tape.

n Important:

Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.
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5. Squeeze the tab on the ink cartridge and pull it straight up. If you cannot remove the ink cartridge, pull it
firmly.

6. Insert the new ink cartridge, and then press it down firmly.

7. Close the scanner unit.

8. Press the <> button.

Ink charging starts.

n Important:

Do not turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.

Related Information
= “Ink Cartridge Codes” on page 92
= “Ink Cartridge Handling Precautions” on page 93

Temporarily Printing with Black Ink

When color ink is expended and black ink still remains when printing from a computer, you can use the following
settings to continue printing for a short time using only black ink.

[d Type of paper: plain papers, Envelope
A Color: Grayscale
(d Borderless: Not selected
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(4 EPSON Status Monitor 3: Enabled (for Windows only)
Because this feature is only available for approximately five days, replace the expended ink cartridge as soon as
possible.

Note:
[d If EPSON Status Monitor 3 is disabled, access the printer driver, click Extended Settings on the Maintenance tab, and
then select Enable EPSON Status Monitor 3.

(1 The available period varies depending on the usage conditions.
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Temporarily Printing with Black Ink - Windows

1. When the following window is displayed, cancel printing.

Color cartridge(s) need to be replaced. Bladk printing is tempararily available.

Epson recommends the genuine Epson cartridges listed above, Click [Replace Cartridge] for ink
cartridge replacement instructions or dick [Close] to see Status Monitor,

¥ou can cancel the job and temporarily continue printing in black ink with the following settings:
- Paper Type: plain papers or Envelope

- Color: Grayscale

- Borderless: Mot Selected

Ifitis not printed correctly with the settings abowve, there may be an error on the previous print
job. Cancel the previous print job on the product and print again.

Replace Cartridge...

The settings you selected are not available.

Bladk printing is temporarily available using the following settings:
- Paper Type: plain papers or Envelope

- Color: Grayscale

- Borderless: Mot Selected

To print with other settings, please replace the expended cartridge(s).

Note:
If you cannot cancel printing from the computer, cancel using the printer's control panel.

2. Access the printer driver window.
3. Clear Borderless on the Main tab.

4. Select plain papers or Envelope as the Paper Type setting on the Main tab.
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Select Grayscale.
Set the other items on the Main and More Options tabs as necessary, and then click OK.
Click Print.

Click Print in Black in the window displayed.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

= “Printing Basics - Windows” on page 53

Temporarily Printing with Black Ink - Mac OS

Note:
To use this feature through a network, connect with Bonjour.

1.

Click the printer icon in the Dock.

Cancel the job.

Note:
If you cannot cancel printing from the computer, cancel using the printer's control panel.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver).

Select On as the Permit temporary black printing setting.

Access the print dialog.

Select Print Settings from the pop-up menu.

Select any paper size except for a borderless size as the Paper Size setting.
Select plain papers or Envelope as the Media Type setting.

Select Grayscale.

10. Set the other items as necessary.

11. Click Print.

Related Information

= “Canceling Printing - Mac OS” on page 74

= “Loading Paper in the Rear Paper Feed” on page 39

= “Printing Basics - Mac OS” on page 55
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Conserving Black Ink when the Black Ink Is Low (for
Windows Only)

When black ink is running low and there is enough color ink remaining, you can use a mixture of color inks to
create black. You can continue printing while preparing a replacement black ink cartridge.

This feature is only available when you select the following settings in the printer driver.
[ Paper Type: plain papers

[ Quality: Standard

(4 EPSON Status Monitor 3: Enabled

Note:
(4 If EPSON Status Monitor 3 is disabled, access the printer driver, click Extended Settings on the Maintenance tab, and
then select Enable EPSON Status Monitor 3.

A Composite black looks slightly different from pure black. In addition, the print speed is reduced.

A To maintain the quality of the print head, black ink is also consumed.

EPSON Status Monitor 3

Black ink is low. You can extend black ink cartridge life by printing with a
mixture of other colors to create composite black.
Do you want to do this for the current print job?

Yes

No

Disable this feature

Options Description

Yes Select to use a mixture of color inks to create black. This window is displayed the next time
you print a similar job.

No Select to continue using the remaining black ink. This window is displayed the next time
you print a similar job.

Disable this feature Select to continue using the remaining black ink. This window is not displayed until you
replace the black ink cartridge and it runs low again.
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Maintaining the Printer

Checking and Cleaning the Print Head

If the nozzles are clogged, the printouts become faint, there is visible banding, or unexpected colors appear. When
print quality has declined, use the nozzle check feature and check if the nozzles are clogged. If the nozzles are
clogged, clean the print head.

n Important:

A Do not open the scanner unit or turn off the printer during head cleaning. If the head cleaning is incomplete, you
may not be able to print.

(A Because print head cleaning uses some ink, clean the print head only if quality declines.

U

When ink is low, you may not be able to clean the print head. Replace the ink cartridge first.

[ If print quality has not improved after repeating nozzle check and head cleaning about four times, wait for at
least six hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary.
We recommend to turn off the printer. If print quality has still not improved, contact Epson support.

(A To prevent the print head from drying out, do not unplug the printer while the power is on.

Checking and Cleaning the Print Head - Control Panel

1.

Load A4-size plain paper in the printer.
Enter Setup from the home screen using the € or P> button, and then press the OK button.
Select Maintenance using the A or V button, and then press the OK button.

Select Print Head Nozzle Check using the A or 'V button, and then press the OK button.
Follow the on-screen instructions to print the nozzle check pattern.

Examine the printed pattern. If there are broken lines or missing segments as shown in the "NG" pattern, the
print head nozzles may be clogged. Go to the next step. If you cannot see any broken lines or missing segments
as in the following "OK" pattern, the nozzles are not clogged. Print head cleaning is not necessary. Select

Finish Nozzle Check using the A or ¥ button, and then press the OK button.
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Note:
The test pattern may vary by model.

Select Print Head Cleaning using the A or ¥ button, and then press the OK button.

Follow the on-screen instructions to clean the print head.

When cleaning is finished, select Print Head Nozzle Check using the A or V button, and then follow the on-
screen instructions to print the nozzle check pattern again. Repeat cleaning and printing the pattern until all
lines are printed completely.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

Checking and Cleaning the Print Head - Windows

1.

Load A4-size plain paper in the printer.
Access the printer driver window.
Click Nozzle Check on the Maintenance tab.

Follow the on-screen instructions.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

= “Windows Printer Driver” on page 118

Checking and Cleaning the Print Head - Mac OS

1.

Load A4-size plain paper in the printer.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

Click Options & Supplies > Utility > Open Printer Utility.
Click Nozzle Check.

Follow the on-screen instructions.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39
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Aligning the Print Head

If you notice a misalignment of vertical lines or blurred images, align the print head.

Aligning the Print Head - Control Panel

1. Load A4-size plain paper in the printer.
2. Enter Setup from the home screen using the  or P button, and then press the OK button.
3. Select Maintenance using the A or V button, and then press the OK button.

4. Select Print Head Alignment using the A or ¥ button, and then press the OK button.
5. Follow the on-screen instructions to print the alignment pattern.

6. Follow the on-screen instructions to align the print head. Find and select the number for the most solid

pattern in each group using the A or ¥ button, and then press the OK button.

#1

il m
3 4

Note:
(A The test pattern may vary by model.

A If print quality is not improved, align the print head from a computer.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

Aligning the Print Head - Windows
1. Load A4-size plain paper in the printer.

2. Access the printer driver window.

3. Click Print Head Alignment on the Maintenance tab.

4. Follow the on-screen instructions.
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Related Information
= “Loading Paper in the Rear Paper Feed” on page 39
= “Windows Printer Driver” on page 118

Aligning the Print Head - Mac OS

1. Load A4-size plain paper in the printer.

2. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

3. Click Options & Supplies > Utility > Open Printer Utility.
4. Click Print Head Alignment.
5. Follow the on-screen instructions.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

Cleaning the Paper Path

When the printouts are smeared or scuffed, clean the roller inside.

n Important:

Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.

1. Make sure there is no dust or stains on the scanner glass and the document cover.
2. Enter Setup from the home screen using the  or P button, and then press the OK button.
3. Select Maintenance using the A or ¥ button, and then press the OK button.

4. Select Paper Guide Cleaning using the A or ¥ button, and then press the OK button.

5. Load A4-size plain paper in the printer.

6. Press the < button.
The paper is ejected from the printer.

Note:
The printer continues to make operating sounds for a while after the paper is ejected. This is normal and not a sign of a
malfunction.

7. Repeat this procedure until the paper is not smeared with ink.
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Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

Cleaning the Scanner Glass

When the copies or scanned images are smeared, clean the scanner glass.

g Important:

Never use alcohol or thinner to clean the printer. These chemicals can damage the printer.

1. Open the document cover.

ey

2. Use a soft, dry, clean cloth to clean the surface of the scanner glass.

Important:

[ If the glass surface is stained with grease or some other hard-to-remove material, use a small amount of
glass cleaner and a soft cloth to remove it. Wipe off all remaining liquid.

(4 Do not press the glass surface too hard.

(1 Be careful not to scratch or damage the surface of the glass. A damaged glass surface can decrease the scan
quality.

Cleaning the Translucent Film

When the printout is not improved after aligning the print head or cleaning the paper path, the translucent film
inside the printer may be smeared.

Items required:
[ Cotton swabs (several)
[d Water with a few drops of detergent (2 to 3 drops of detergent in 1/4 cup of tap water)

[ Light for checking smears
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n Important:

Do not use cleaning liquid other than water with a few drops of detergent.

1. Turn off the printer by pressing the O button.

2. Open the scanner unit.

3. Check if the translucent film is smeared. Smears are easier to see if you use a light.

If there are smears (such as finger marks or grease) on the translucent film (A), go to the next step.

A: Translucent film

B: Rail
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n Important:

Be careful not to touch the rail (B). Otherwise, you may not be able to print. Do not wipe off the grease on the
rail, because this is necessary for operations.

4. Moisten a cotton swab with the water with a few drops of detergent so that it is not dripping water, and then
wipe the smeared part.

n Important:

Wife off the smear gently. If you press the cotton swab too hard to the film, the springs of the film may be
dislocated and the printer may be damaged.

5. Use a new dry cotton swab to wipe the film.

n Important:

Do not leave any fibers on the film.

Note:
To prevent the smear from spreading, frequently replace the cotton swab with a new one.

6. Repeat steps 4 and 5 until the film is not smeared.

7. Visually check that the film is not smeared.

Saving Power

The printer enters sleep mode or turns off automatically if no operations are performed for a set period. You can
adjust the time before power management is applied. Any increase will affect the product's energy efficiency. Please
consider the environment before making any change.

Saving Power - Control Panel

1. Enter Setup from the home screen using the € or P> button, and then press the OK button.

2. Select Printer Setup using the A or ¥ button, and then press the OK button.
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Select Power Off Timer or Sleep Timer using the A or ¥ button, and then press the OK button.

Select the setting using the A or ¥ button, and then press the OK button.

Saving Power - Windows

1.

Access the printer driver window.
Click Printer and Option Information on the Maintenance tab.

Select the time period before the printer enters sleep mode as the Sleep Timer setting, and click Send. To
make the printer turn off automatically, select the time period as the Power Off Timer setting, and click Send.

Click OK.

Related Information

= “Windows Printer Driver” on page 118

Saving Power - Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

Click Options & Supplies > Utility > Open Printer Utility.
Click Printer Settings.

Select the time period before the printer enters sleep mode as the Sleep Timer setting, and click Apply. To
make the printer turn off automatically, select the time period as the Power Off Timer setting, and click

Apply.
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Menu Options for Setup Mode

By selecting Setup on the home screen from the control panel, you can make printer settings or perform printer
maintenance.

Menu Options for Ink Levels

Select the menus on the control panel as described below.

Setup > Ink Levels

Displays the approximate levels of the ink cartridges. When an ! icon is displayed, the ink cartridge is running low.
When a X mark is displayed, the ink cartridge is expended.

Menu Options for Maintenance

Select the menus on the control panel as described below.

Setup > Maintenance

Print Head Nozzle Check

Prints a pattern to check if the print head nozzles are clogged.

Print Head Cleaning

Cleans clogged nozzles in the print head.

Print Head Alignment
Adjusts the print head to improve print quality.

Ink Cartridge Replacement

Use this feature to replace the ink cartridges before the ink is expended.

Paper Guide Cleaning

Cleans the roller inside the printer. Use this feature when your printouts are smeared or when paper is
not fed correctly.

Related Information

® “Checking and Cleaning the Print Head” on page 103
= “Aligning the Print Head” on page 105

= “Replacing Ink Cartridges” on page 95

= “Cleaning the Paper Path” on page 106
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Menu Options for Printer Setup

Select the menus on the control panel as described below.

Setup > Printer Setup

Paper Source Settings:

Paper Setup:

Select the paper size and paper type you loaded in the paper sources.

Paper Setting Alert:

Select On to display a warning if the paper settings (print settings) for the print job do not
match the printer's paper settings that you made when you loaded the paper. This setting
prevents misprinting. However, the notification screen is not displayed when Paper
Configuration is disabled in the following menu.

Setup > Printer Setup > Paper Source Settings

Paper Configuration:

Select On to display the paper settings screen automatically by referring to Setup > Printer
Setup > Paper Source Settings > Paper Setup when paper is loaded in the paper source. If you
disable this feature, you cannot print from an iPhone or iPad using AirPrint

Quiet Mode:

Select On to reduce noise during printing, however, this may lower the print speed. Depending on
the paper type and print quality settings you selected, there may be no difference in the printer's noise
level.

Power Off Timer:
Select to turn the printer off if it is not used for a specified period of time. You can adjust the time
before power management is applied. Any increase will affect the product’s energy efficiency. Please
consider the environment before making any change.

Language:

Select the language used on the LCD screen.

Sleep Timer:

Adjust the time period to enter a sleep mode (energy saving mode) when the printer has not
performed any operations. The LCD screen turns black when the setting time passes.

Related Information

= “Saving Power” on page 109

Menu Options for Network Settings

Select the menus on the control panel as described below.

Setup > Network Settings
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Network Status

Displays or prints the network settings and connection status.

Wi-Fi Setup
[ Wi-Fi Setup Wizard
Select a SSID, enter a password, and then connect the printer to a wireless (Wi-Fi) network.

(A Push Button Setup (WPS)

Connects the printer to a wireless (Wi-Fi) network by pressing a WPS push button on a wireless
router.

(4 PIN Code Setup (WPS)

In the wireless router utility, enter the PIN code displayed on the printer's screen to connect the
printer to a wireless (Wi-Fi) network.

1 Wi-Fi Auto Connect

Connects the printer to a wireless (Wi-Fi) network using a computer that is connected to the access
point. Insert the software disc supplied with the printer into the computer, and then follow the on-
screen instructions. When you are prompted to operate the printer, run this menu.

[ Disable Wi-Fi

Disables the connection by turning off the wireless signal without deleting the network information.
To enable the connection, set up the wireless (Wi-Fi) network again.

[ Wi-Fi Direct Setup

Connects the printer to a wireless (Wi-Fi) network without a wireless router.

Manual Network Setup

Changes the network settings, such as the device name or TCP/IP.

Connection Check

Checks the status of the network connection and prints the network connection report. If there are any
problems with the connection, see the report to solve the problem.

Related Information

= “Printing a Network Status Sheet” on page 33

= “Making Wi-Fi Settings from the Printer” on page 21
= “Making Advanced Network Setting” on page 25

= “Printing a Network Connection Report” on page 27

Menu Options for Epson Connect Services

Select the menus on the control panel as described below.

Setup > Epson Connect Services

Register/Delete:
Register or delete the printer to or from the Epson Connect services.

For usage guides, see the following portal website.
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https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Suspend/Resume:

Select whether to suspend or resume Epson Connect services.

Email Address:

Check the printer's email address that is registered to the Epson Connect services.
Status:

Check whether or not the printer is registered and connected to the Epson Connect services.

Related Information

= “Epson Connect Service” on page 116

Menu Options for Google Cloud Print Services

Select the menus on the control panel as described below.

Setup > Google Cloud Print Services

Suspend/Resume

Select whether to suspend or resume the Google Cloud Print services.

Unregister

Unregister the Google Cloud Print services.

Status

Check whether or not the printer is registered and connected to the Google Cloud Print services.

For registration and usage guides, see the following portal website.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Menu Options for File Sharing Setup

Select the menus on the control panel as described below.

Setup > File Sharing Setup

Select the connection method between the printer and a computer that will have write access to the memory card
inserted in the printer. Read and write access is given to the computer with the priority connection. Only read
access is given to other computers.
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Related Information

= “Accessing a Memory Card From a Computer” on page 167

Menu Options for Firmware Update

Select the menus on the control panel as described below.

Setup > Firmware Update

Update

Checks if the latest version of the firmware has been uploaded to the network server. If an update is
available, you can select whether or not to start updating.

Current Version

Displays the current firmware version of your printer.
Notification

Checks for firmware updates periodically and notifies you if an update is available.

Related Information

= “Updating Applications and Firmware” on page 129

Menu Options for Restore Default Settings

Select the menus on the control panel as described below.

Setup > Restore Default Settings

Network Settings

Resets the network settings to their defaults.

All Except Network Settings

Resets all settings except for network settings to their defaults.

All Settings
Resets all settings to their defaults.
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Network Service and Software
Information

This section introduces the network services and software products available for your printer from the Epson
website or the supplied software disc.

Epson Connect Service

By using Epson Connect service available on the Internet, you can print from your smartphone, tablet PC, or
laptop, anytime and practically anywhere.

The features available on the Internet are as follows.

Email Print Epson iPrint remote print Scan to Cloud Remote Print Driver

v/ 4 4 4

See the Epson Connect portal website for details.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Web Config

Web Config is an application that runs in a web browser, such as Internet Explorer and Safari, on a computer or
smart device. You can confirm the printer status or change the network service and printer settings. To use the
Web Config, connect the printer and the computer or device to the same network.

Note:
The following browsers are supported.
0s Browser
Windows XP or later Internet Explorer 8 or later, Firefox”, Chrome”
Mac OS X v10.6.8 or later Safari”, Firefox”, Chrome”
i0s” Safari®
Android 2.3 or later Default browser
Chrome OS” Default browser

* Use the latest version.
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Running Web Config on a Web Browser

1. Check the printer's IP address.
Select Setup > Network Settings > Network Status from the home screen, and then check the printer's IP
address.
2. Launch a Web browser from a computer or smart device, and then enter the printer's IP address.
Format:
IPv4: http://the printer's IP address/
IPv6: http://[the printer's IP address]/
Examples:
IPv4: http://192.168.100.201/
IPv6: http://[2001:db8::1000:1]/

Note:
Using the smart device, you can also run Web Config from the maintenance screen of Epson iPrint.

Related Information

= “Printing Using Epson iPrint” on page 71

Running Web Config on Windows

When connecting a computer to the printer using WSD, follow the steps below to run Web Config.

1. Access the devices and printers screen in Windows.
(4 Windows 10

Right-click the start button or press and hold it, and then select Control Panel > View devices and printers
in Hardware and Sound.

J Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound (or
Hardware).

[ Windows 7
Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.
[J Windows Vista

Click the start button, and select Control Panel > Printers in Hardware and Sound.
2. Right-click on your printer and select Properties.

3. Select the Web Service tab and click the URL.

Running Web Config on Mac OS

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.
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2. Click Options & Supplies> Show Printer Webpage.

Windows Printer Driver

The printer driver controls the printer according to the commands from an application. Making settings on the
printer driver provides the best printing results. You can also check the status of the printer or keep it in top
operating condition using the printer driver utility.

Note:
You can change the language of the printer driver. Select the language you want to use from the Language setting on the
Maintenance tab.

Accessing the printer driver from applications
To make settings that apply only to the application you are using, access from that application.
Select Print or Print Setup from the File menu. Select your printer, and then click Preferences or Properties.

Note:
Operations differ depending on the application. See the application’s help for details.

Accessing the printer driver from the control panel
To make settings that apply to all of the applications, access from the control panel.

J Windows 10

Right-click the start button or press and hold it, and then select Control Panel > View devices and printers in
Hardware and Sound. Right-click on your printer, or press and hold it and then select Printing preferences.

[J Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound. Right-click
on your printer, or press and hold it and then select Printing preferences.

[ Windows 7

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound. Right-
click on your printer and select Printing preferences.

[J Windows Vista

Click the start button, and select Control Panel > Printers in Hardware and Sound. Right-click on your printer
and select Select printing preferences.

J Windows XP

Click the start button, and select Control Panel > Printers and Other Hardware > Printers and Faxes. Right-
click on your printer and select Printing preferences.

Accessing the printer driver from the printer icon on the task bar
The printer icon on the desktop task bar is a shortcut icon allowing you to quickly access the printer driver.

If you click the printer icon and select Printer Settings, you can access the same printer settings window as the one
displayed from the control panel. If you double-click this icon, you can check the status of the printer.

Note:
If the printer icon is not displayed on the task bar, access the printer driver window, click Monitoring Preferences on the
Maintenance tab, and then select Register the shortcut icon to the taskbar.
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Starting the utility

Access the printer driver window. Click the Maintenance tab.

Guide to Windows Printer Driver

Help is available in the printer driver for Windows. To view explanations of the setting items, right-click on each
item, and then click Help.

Main Tab
You can make basic settings for printing, such as paper type or paper size.

You can also make settings for printing both sides of the paper or printing multiple pages on one sheet.
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More Options Tab

You can select additional layout and printing options such as changing the size of a printout or making color
corrections.

I!E!i Prnting Preferences b

Min  More Optisns  Muntenance
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Maintenance Tab

You can run maintenance features such as nozzle check and print head cleaning, and by starting EPSON Status
Monitor 3, you can check printer status and error information.

= Prnting Preferences et

Pofbny More Options  Mentenancs

@ Mozde Check @ EPSOM Status Monibor 3

b | Fead Cleaning E Moritoring Preferences

P A Print Head Algnment
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] Print Queve
@ﬂ Job Arranger Lite % Printer and Gption Information
Language Englsh (Enghsh) » M saftware Updats
Onlne Order
Wersion X0, XX T - ¢
ok Cancal Halp

Making Operation Settings for the Windows Printer Driver
You can make settings such as enabling EPSON Status Monitor 3.

1. Access the printer driver window.

2. Click Extended Settings on the Maintenance tab.

3. Make the appropriate settings, and then click OK.

See the online help for explanations of the setting items.

Related Information

= “Windows Printer Driver” on page 118

Mac OS Printer Driver

The printer driver controls the printer according to the commands from an application. Making settings on the
printer driver provides the best printing results. You can also check the status of the printer or keep it in top
operating condition using the printer driver utility.
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Accessing the printer driver from applications

Click Page Setup or Print on the File menu of your application. If necessary, click Show Details (or ¥) to expand
the print window.

Note:
Depending on the application being used, Page Setup may not be displayed in the File menu, and the operations for
displaying the print screen may differ. See the application's help for details.

Starting the utility

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Utility > Open Printer Utility.

Guide to Mac OS Printer Driver

Print dialog

Switch the pop-up menu on the center of the screen to show more items.

Printer:  EPSOMN XXXX <)
Presets: Default Settings ﬂ
Copies: |1

Pages: D All
From: 1 ta: 1

Paper Size: A4 Ed 2100y 287 mm
Orientation: | i LS

TextEdit ﬁ

Print header and footer
Rewrap contents to fit page

Cancel “

Pop-up Menu Descriptions

Layout You can select a layout for printing several pages on one sheet or select to print a border.

Color Matching You can adjust the colors.

Paper Handling You can reduce or enlarge the size of the print job to automatically fit the paper size you
loaded.

Cover Page You can select a cover for your documents. Select Cover Page Type to set the contents to be
printed on the cover.

Print Settings You can make the basic print settings such as paper type and print quality.
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Pop-up Menu Descriptions

Color Options When you select EPSON Color Controls from the Color Matching menu, you can select a
color correction method.

Note:
On OS X Mountain Lion or later, if Print Settings menu is not displayed, Epson printer driver has not been installed
correctly.

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer,
and then add the printer again. Access the following website, and then enter the product name. Go to Support, and then see
Tips.

http://epson.sn

Epson Printer Utility

You can run a maintenance feature such as nozzle check and print head cleaning, and by starting EPSON Status
Monitor, you can check printer status and error information.

@ Epson Printer Utility 4

Buy Epson Ink

EpSON XX-XXX Series

I Ready

Version XXX (X.XX)

© Connected Update
% A\ﬂ N/ Y
EPSON Status Nozzle Check Head Cleaning Print Head
Monitor Alignment
J,{.
ML
Ink Cartridge
Replacement
Printer List Printer Settings
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Making Operation Settings for the Mac OS Printer Driver

Accessing the Operation Settings Window of the Mac OS Printer Driver

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver).

Operation Settings of the Mac OS Printer Driver

(1 Skip Blank Page: Avoids printing blank pages.

(d Quiet Mode: Reduces the noise the printer makes, however, this may reduce print speed. Depending on the
paper type and print quality settings you selected, there may be no difference in the printer's noise level.

(d Permit temporary black printing: Prints only with black ink temporarily.

(J High Speed Printing: Prints when the print head moves in both directions. The print speed is faster, but the
quality may decline.

[J Warning Notifications: Allows the printer driver to display warning notifications.

[J Establish bidirectional communication: Usually, this should be set to On. Select Off when acquiring the printer
information is impossible because the printer is shared with Windows computers on a network or for any other
reason.

Related Information

= “Temporarily Printing with Black Ink - Mac OS” on page 101

Epson Scan 2 (Scanner Driver)

Epson Scan 2 is an application for controlling scanning. You can adjust the size, resolution, brightness, contrast,
and quality of the scanned image.

Note:
You can also start Epson Scan 2 from a TWAIN-compliant scanning application.

Starting on Windows
[ Windows 10
Click the start button, and then select EPSON > Epson Scan 2.
(d Windows 8.1/Windows 8
Enter the application name in the search charm, and then select the displayed icon.

[ Windows 7/Windows Vista/Windows XP
Click the start button, and then select All Programs or Programs > EPSON > Epson Scan 2> Epson Scan 2.

Starting on Mac OS

Note:
Epson Scan 2 does not support the Mac OS fast user switching feature. Turn off fast user switching.
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Select Go > Applications > Epson Software > Epson Scan 2.

Related Information

= “Installing Applications” on page 129

Epson Event Manager

Epson Event Manager is an application that allows you to manage scanning from the control panel and save images
to a computer. You can add your own settings as presets, such as the document type, the save folder location, and
the image format. See the application's help for details.

Starting on Windows
1 Windows 10
Click the start button, and then select Epson Software > Event Manager.

[ Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[d Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > Epson Software > Event Manager.

Starting on Mac OS

Select Go > Applications > Epson Software > Event Manager.

Related Information
= “Scanning to a Computer” on page 80

= “Installing Applications” on page 129

Epson Easy Photo Print

Epson Easy Photo Print is an application that allows you to easily print photos with various layouts. You can
preview the photo image and adjust the images or position. You can also print photos with a frame. See the
application's help for details.

Note:
To use this application, the printer driver needs to be installed.

Starting on Windows
[ Windows 10

Click the start button, and then select Epson Software > Epson Easy Photo Print.
(d Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[ Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > Epson Software > Epson Easy Photo
Print.
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Starting on Mac OS
Select Go > Applications > Epson Software > Epson Easy Photo Print.

Related Information

= “Installing Applications” on page 129

E-Web Print (for Windows Only)

E-Web Print is an application that allows you to easily print web pages with various layouts. See the application's
help for details. You can access the help from the E-Web Print menu on the E-Web Print tool bar.

Note:
Check for supported browsers and the latest version from the download site.

Starting
When you install E-Web Print, it is displayed in your browser. Click Print or Clip.

Related Information

= “Installing Applications” on page 129

Easy Photo Scan

Easy Photo Scan is an application that allows you to scan photos and easily send the scanned image to a computer
or cloud service. You can also easily adjust the scanned image. See the application's help for details.

Note:
To use this application, the scanner driver Epson Scan 2 needs to be installed.

Starting on Windows
(1 Windows 10
Click the start button, and then select All apps > Epson Software > Easy Photo Scan.

[ Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[d Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > Epson Software > Easy Photo Scan.

Starting on Mac OS
Select Go > Applications > Epson Software > Easy Photo Scan.

Related Information

= “Installing Applications” on page 129
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EPSON Software Updater

EPSON Software Updater is an application that checks for new or updated software on the internet and installs it.
You can also update the printer's firmware and manual.

Starting on Windows
(d Windows 10

Click the start button, and then select Epson Software > EPSON Software Updater.
(4 Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[d Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs (or Programs) > Epson Software > EPSON Software
Updater.

Note:
You can also start EPSON Software Updater by clicking the printer icon on the task bar on the desktop, and then selecting
Software Update.

Starting on Mac OS
Select Go > Applications > Epson Software > EPSON Software Updater.

Related Information

= “Installing Applications” on page 129

Uninstalling Applications

Note:
Log on to your computer as an administrator. Enter the administrator password if the computer prompts you.

Uninstalling Applications - Windows

1. Press the O button to turn off the printer.
2. Quit all running applications.

3. Open Control Panel:
(d Windows 10
Right-click the start button or press and hold it, and then select Control Panel.

(d Windows 8.1/Windows 8
Select Desktop > Settings > Control Panel.

J Windows 7/Windows Vista/Windows XP
Click the start button and select Control Panel.
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Open Uninstall a program (or Add or Remove Programs):

[ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista

Select Uninstall a program in Programs.

(1 Windows XP
Click Add or Remove Programs.

Select the application you want to uninstall.

Uninstall the applications:

[ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista
Click Uninstall/Change or Uninstall.

J Windows XP

Click Change/Remove or Remove.

Note:
If the User Account Control window is displayed, click Continue.

Follow the on-screen instructions.

Uninstalling Applications - Mac OS

1.

Download the Uninstaller using EPSON Software Updater.

Once you have downloaded the Uninstaller, you do not need to download it again each time you uninstall the
application.

Press the () button to turn off the printer.

To uninstall the printer driver, select System Preferences from the ‘ menu > Printers & Scanners (or Print
& Scan, Print & Fax), and then remove the printer from the enabled printers list.

Quit all running applications.
Select Go > Applications > Epson Software > Uninstaller.

Select the application you want to uninstall, and then click Uninstall.

n Important:

The Uninstaller removes all drivers for Epson inkjet printers on the computer. If you use multiple Epson inkjet
printers and you only want to delete some drivers, delete all of them first, and then install the necessary printer
driver again.

Note:

If you cannot find the application you want to uninstall in the application list, you cannot uninstall using the
Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you want to uninstall,
and then drag it to the trash icon.

Related Information

= “Installing Applications” on page 129
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Installing Applications

Connect your computer to the network and install the latest version of applications from the website.

Note:
(A Log on to your computer as an administrator. Enter the administrator password if the computer prompts you.

(A When reinstalling an application, you need to uninstall it first.
1. Quit all running applications.

2. When installing the printer driver or Epson Scan 2, disconnect the printer and the computer temporarily.
Note:
Do not connect the printer and the computer until you are instructed to do so.

3. Install the applications by following the instructions on the website below.
http://epson.sn

Note:
If you are using a Windows computer and you cannot download applications from the website, install them from the
software disc that came with the printer.

Related Information

= “Uninstalling Applications” on page 127

Updating Applications and Firmware

You may be able to clear certain problems and improve or add functions by updating the applications and the
firmware. Make sure you use the latest version of the applications and firmware.

1. Make sure that the printer and the computer are connected, and the computer is connected to the internet.

2. Start EPSON Software Updater, and update the applications or the firmware.

n Important:
Do not turn off the computer or the printer while updating.

Note:
If you cannot find the application you want to update in the list, you cannot update using the EPSON Sofiware
Updater. Check for the latest versions of the applications from your local Epson website.

http://www.epson.com

Related Information
= “EPSON Software Updater” on page 127
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Updating the Printer's Firmware using the Control Panel
If the printer is connected to the Internet, you can update the printer's firmware using the control panel. By

updating the firmware, the printer's performance may improve, or new functions may be added. You can also set
the printer to regularly check for firmware updates and notify you if any are available.

1. Enter Setup from the home screen using the  or P button, and then press the OK button.
2. Select Firmware Update using the A or ¥ button, and then press the OK button.

3. Select Update using the A or ¥ button, and then press the OK button.

Note:

Select Notification > On to set the printer to regularly check for available firmware updates.
4. Check the message displayed on the screen and press the OK button.

The printer starts searching for available updates.

5. If a message is displayed on the LCD screen informing you that a firmware update is available, follow the on-
screen instructions to start the update.

n Important:

(A Do not turn off or unplug the printer until the update is complete; otherwise, the printer may malfunction.

[ If the firmware update is not completed or is unsuccessful, the printer does not start up normally and
"Recovery Mode" is displayed on the LCD screen the next time the printer is turned on. In this situation, you
need to update the firmware again using a computer. Connect the printer to the computer with a USB cable.
While "Recovery Mode" is displayed on the printer, you cannot update the firmware over a network
connection. On the computer, access your local Epson website, and then download the latest printer
firmware. See the instructions on the website for the next steps.
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Solving Problems

Checking the Printer Status

Checking Messages on the LCD Screen

If an error message is displayed on the LCD screen, follow the on-screen instructions or the solutions below to
solve the problem.

Error Messages

Solutions

Printer error. Turn power off and on again. For
details, see your documentation.

If the error message still appears after turning the power off and on
again, contact Epson support.

Operation canceled. Error while saving.

The memory card may be damaged. Check if your memory card is
available.

You need to replace the following ink
cartridge(s).

To ensure you receive premium print quality and to help protect your
print head, a variable ink safety reserve remains in the cartridge when
your printer indicates it is time to replace the cartridge. Replace the
cartridge when you are prompted to do so.

Paper Configuration is disabled. Some features
may not be available. For details, see your
documentation.

If Paper Configuration is disabled, you cannot use AirPrint. To use
AirPrint, enable Paper Configuration.

The printer's ink pad is nearing the end of its
service life. Please contact Epson Support.

Contact Epson or an authorised Epson service provider to replace the
ink pad*. It is not a user-serviceable part. The message will be displayed
until the ink pad is replaced.

Press the <> button to resume printing.

The printer's ink pad is at the end of its service
life. Please contact Epson Support.

Contact Epson or an authorised Epson service provider to replace the
ink pad*. It is not a user-serviceable part.

Communication error. Connect computer.

Connect the computer and the printer correctly. If you are connecting
over a network, see the page that describes the network connection
method from the computer.

If the error message is displayed during scanning, make sure that Epson
Scan 2 and Epson Event Manager are installed on the computer.

Combination of IP address and subnet mask is
invalid. See documentation.

Enter the correct IP address or default gateway. Contact the person who
setup the network for assistance.

Update the root certificate to use cloud services.

Run Web Config, and then update the root certificate.

Recovery Mode

The printer has started in recovery mode because the firmware update
failed. Follow the steps below to try to update the firmware again.

1. Connect the computer and the printer with a USB cable. (During
recovery mode, you cannot update the firmware over a network
connection.)

2. Visit your local Epson website for further instructions.
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* In some print cycles a very small amount of surplus ink may be collected in the ink pad. To prevent ink leakage
from the pad, the printer is designed to stop printing when the pad has reached its limit. Whether and how often
this is required will vary according to the number of pages you print, the type of material that you print and the
number of cleaning cycles that the printer performs. The need for replacement of the pad does not mean that your
printer has ceased to operate in accordance with its specifications. The printer will advise you when the pad
requires replacing and this can only be performed by an authorised Epson Service provider. The Epson warranty
does not cover the cost of this replacement.

Related Information

= “Contacting Epson Support” on page 168

= “Menu Options for Printer Setup” on page 112

= “Supported Memory Card Specifications” on page 162
= “Installing Applications” on page 129

= “Web Config” on page 116

= “Updating Applications and Firmware” on page 129

Checking the Printer Status - Windows
1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab.

Note:

(A You can also check the printer status by double-clicking the printer icon on the taskbar. If the printer icon is not
added to the taskbar, click Monitoring Preferences on the Maintenance tab, and then select Register the shortcut
icon to the taskbar.

[d If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.

Related Information

= “Windows Printer Driver” on page 118

Checking the Printer Status - Mac OS

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

You can check the printer status, ink levels, and error status.

Removing Jammed Paper

Check the error displayed on the control panel and follow the instructions to remove the jammed paper including
any torn pieces. Next, clear the error.
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n Important:

Remove the jammed paper carefully. Removing the paper vigorously may cause damage to the printer.

Removing Jammed Paper from the Rear Paper Feed

Remove the jammed paper.

Removing Jammed Paper from the Output Tray

Remove the jammed paper.

Removing Jammed Paper from Inside the Printer

A Caution:

[ Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be
injured.

[ Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating,
it could cause an injury. Be careful not to touch the protruding parts to avoid injury.
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Open the scanner unit with the document cover closed.

1.

2. Remove the jammed paper.

n Important:

Do not touch the white flat cable or translucent film inside the printer. Doing so may cause a malfunction.
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3. Close the scanner unit.

Paper Does Not Feed Correctly

Check the following points, and then take the appropriate actions to solve the problem.

[ Place the printer on a flat surface and operate in the recommended environmental conditions.
[d Use paper supported by this printer.

[ Follow the paper handling precautions.

(d Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load
above the line indicated by the triangle symbol on the edge guide.

[J Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

Related Information

= “Environmental Specifications” on page 164
= “Paper Handling Precautions” on page 37
= “Available Paper and Capacities” on page 38
= “List of Paper Types” on page 39

Paper Jams

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.

[d Load one sheet of paper at a time if you have loaded several sheets of paper.
Related Information

= “Removing Jammed Paper” on page 132
= “Loading Paper in the Rear Paper Feed” on page 39

Paper Feeds at a Slant

Load paper in the correct direction, and slide the edge guides against the edges of the paper.
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Related Information

= “Loading Paper in the Rear Paper Feed” on page 39

Several Sheets of Paper are Fed at a Time

(d Load one sheet of paper at a time.

[ When several sheets of paper are fed at a time during manual 2-sided printing, remove any paper which is
loaded in the printer before you reload the paper.

Paper Out Error Occurs

When a paper out error occurs although paper is loaded in the rear paper feed, reload paper against the right edge
of the rear paper feed.

Power and Control Panel Problems

Power Does Not Turn On
[d Make sure the power cord is securely plugged in.

0 Hold down the O button for a little longer.

Power Does Not Turn Off

Hold down the O button for a little longer. If you still cannot turn off the printer, unplug the power cord. To
prevent the print head from drying out, turn the printer back on and turn it off by pressing the O button.

LCD Screen Gets Dark

The printer is in sleep mode. Press any button on the control panel to return the LCD screen to its former state.

Cannot Print from a Computer

Checking the Connection (USB)

(d Connect the USB cable securely to the printer and the computer.
[ If you are using a USB hub, try to connect the printer directly to the computer.

[ If the USB cable cannot be recognized, change the port, or change the USB cable.

136



User's Guide

Solving Problems

[ If the printer cannot print using a USB connection, try the following.

Disconnect the USB cable from the computer. Right-click on the printer icon displayed on the computer, and
then select Remove Device. Next, connect the USB cable to the computer and try a test print.

Re-set the USB connection by following the steps in this manual for changing the connection method to a
computer. See the related information link below for details.

~ Printers (19)
~. - 3 Y 4 =~
| Open
KHKXX Series | Open in new window b :
See what's printing
= Set as default printer
|
— Printing preferences &
— Printer properties : |
Create shortcut
EPSON [ 2 E
woooooxd E;" Remave device ] 0
Series | roubleshoo
Properties
- - = -
XXXKX Series Manufacturer:  Seib
- Model: XX
<A~ Description: Eps

Related Information

= “Changing the Connection Method to a Computer” on page 34

Checking the Connection (Network)

[d When you have changed your access point or provider, try making network settings for the printer again.
Connect the computer or smart device to the same SSID as the printer.

[ Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn on the
devices in the following order; access point, computer or smart device, and then printer. Move the printer and
computer or smart device closer to the access point to help with radio wave communication, and then try to
make network settings again.

(d Print the network connection report. See the related information link below for details. If the report shows that
the network connection failed, check the network connection report and then follow the printed solutions.

[ If the IP address assigned to the printer is 169.254 XXX. XXX, and the subnet mask is 255.255.0.0, the IP address
may not be assigned correctly. Restart the access point or reset the network settings for the printer. If this does
not solve the problem, see the documentation for the access point.

[d Try accessing any website from your computer to make sure that your computer's network settings are correct.
If you cannot access any website, there is a problem on the computer. Check the network connection of the
computer.

Related Information

= “Connecting to a Computer” on page 20

= “Printing a Network Connection Report” on page 27
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Checking the Software and Data

[d Make sure that a genuine Epson printer driver is installed. If a genuine Epson printer driver is not installed, the
available functions are limited. We recommend using a genuine Epson printer driver. See the related
information link below for details.

[ If you are printing a large data size image, the computer may run out of memory. Print the image at a lower
resolution or a smaller size.

Related Information
= “Checking for Genuine Epson Printer Drivers” on page 138
= “Installing Applications” on page 129

Checking for Genuine Epson Printer Drivers

You can check if a genuine Epson printer driver is installed on your computer by using one of the following
methods.

Windows

Select Control Panel > View devices and printers (Printers, Printers and Faxes), and then do the following to
open the print server properties window.

J Windows 10/Windows 8.1/Windows 8/Windows 7

Click the printer icon, and then click Print server properties at the top of the window.

[ Windows Vista

Right-click on the Printers folder, and then click Run as administrator > Server Properties.

(d Windows XP

From the File menu, select Server Properties.
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Click the Driver tab. If your printer name is displayed in the list, a genuine Epson printer driver is installed on
your computer.

& Devices and Printers

« « 4 x> Control Panel + Hardware and Sound > Devices and Printers * ve

Fle Edit View Tools Help

Piflodzie Gdfloprim Smofmieprmees Fammmisies
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L
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Installed printer drivers:
e
Ty MName Processor Type &
— EPSON X3OXXXX Series 3 - User Mode
EPSON
OO
Series
-
XXX
-
——
v
Add... Remove... Properties
O Change Driver Settings
Sance oy
Mac OS

Select System Preferences from the :‘. menu > Printers & Scanners (or Print & Scan, Print & Fax), and then

select the printer. Click Options & Supplies, and if the Options tab and Utility tab are displayed on the window, a
genuine Epson printer driver is installed on your computer.

Printers & Scanners

General Supply Levels| mmw |

Open Printer Utility
Print Test Page

Clean Print Heads

concel_ (N

Related Information

= “Installing Applications” on page 129
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Checking the Printer Status from the Computer (Windows)

Click Print Queue on the printer driver's Maintenance tab, and then check the following.
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[ Check if there are any paused print jobs.
If unnecessary data remains, select Cancel all documents from the Printer menu.
[d Make sure the printer is not offline or pending.

If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

EPSOMN JOONN00L Series 0 =

[d Make sure the printer is selected as the default printer from the Printer menu (there should be a check mark on
the menu item).

If the printer is not selected as the default printer, set it as the default printer. If there are multiple icons in
Control Panel > View devices and printers (Printers, Printers and Faxes), see the following to select the icon.

Example)
USB connection: EPSON XXXX Series
Network connection: EPSON XXXX Series (network)

If you install the printer driver multiple times, copies of printer driver may be created. If copies such as "EPSON

XXXX Series (copy 1)" are created, right-click the copied driver icon, and then click Remove Device.

[d Make sure the printer port is selected correctly in Property > Port from the Printer menu as follows.

Select "USBXXX" for a USB connection, or "EpsonNet Print Port" for a network connection.

Checking the Printer Status from the Computer (Mac OS)
Make sure the printer status is not Pause.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
double-click the printer. If the printer is paused, click Resume (or Resume Printer).
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When You Cannot Make Network Settings

(d Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn on the
devices in the following order; access point, computer or smart device, and then printer. Move the printer and
computer or smart device closer to the access point to help with radio wave communication, and then try to
make network settings again.

[ Select Setup > Network Settings > Connection Check, and then print the network connection report. If an
error has occurred, check the network connection report and then follow the printed solutions.

Related Information
= “Messages and Solutions on the Network Connection Report” on page 28

= “Cannot Connect from Devices Even Though Network Settings are No Problems” on page 141

Cannot Connect from Devices Even Though Network Settings are
No Problems

If you cannot connect from the computer or smart device to the printer even though the network connection
report does not show any problems, see the following.

(4 When you are using multiple access points at the same time, you may not be able to use the printer from the
computer or smart device depending on the settings of the access points. Connect the computer or smart device
to the same access point as the printer.

Disable the tethering function on the smart device if it is enabled.
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(J You may not be able to connect to the access point when the access point has multiple SSIDs and devices are
connected to different SSIDs on the same access point. Connect the computer or smart device to the same SSID
as the printer.

7 ~ 7
A SSIDT:XXXXX-G1 4 SSIDTXXXXX-G1
= SSID2:XXXXX-G2 SSID2:XXXXX-G2
= 7 -> ~
;
D
SSIDT:XXXXX-G1 SSID2:XXXXX-G2 SSID2:XXXXX-G2

[J An access point that is compliant with both IEEE802.11a and IEEE802.11g has SSIDs of 2.4 GHz and 5 GHz. If
you connect the computer or smart device to a 5 GHz SSID, you cannot connect to the printer because the
printer only supports communication over 2.4 GHz. Connect the computer or smart device to the same SSID as
the printer.

N
N

-
N 5GHz  SSID:XXXXX_A N
— 2.4GHz SSID:XXXXX_G - 2.4GHz SSID:XXXXX_G

a ===

SSID:XXXXX_A SSID:XXXXX_G SSID:XXXXX_G

[d Most access points have a privacy separator feature that blocks communication between connected devices. If
you cannot communicate between the printer and the computer or smart device even if they are connected to
the same network, disable the privacy separator on the access point. See the manual provided with the access

point for details.
OFF

_ ‘;ﬂ:’@ _

ON
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Related Information
= “Checking the SSID Connected to the Printer” on page 143
= “Checking the SSID for the Computer” on page 143

Checking the SSID Connected to the Printer

Select Setup > Network Settings > Network Status. SSIDs are displayed on each Wi-Fi network and Wi-Fi Direct
network.

Checking the SSID for the Computer

Windows

Click (17 in the task tray on the desktop. Check the name of the connected SSID from the list displayed.

143



User's Guide

Solving Problems

Mac OS

Click the Wi-Fi icon at the top of the computer screen. A list of SSIDs is displayed and the connected SSID is
indicated with a check mark.

= Eica)

Turn Wi-Fi Off

W

Cannot Print from an iPhone or iPad

[d Connect the iPhone or iPad to the same network (SSID) as the printer.
(d Enable Paper Configuration in the following menus.
Setup > Printer Setup > Paper Source Settings > Paper Configuration

[J Enable the AirPrint setting on Web Config.

Related Information

= “Connecting to a Smart Device” on page 21
= “Web Config” on page 116

Printing is Paused

If you are printing a large data size image, printing may be paused and the paper may be ejected. Print the image at
a lower resolution or a smaller size.

Printout Problems

Printout is Scuffed or Color is Missing

If you have not used the printer for a long time, the print head nozzles may be clogged and ink drops may not be
discharged. Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.
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Related Information

= “Checking and Cleaning the Print Head” on page 103

Banding or Unexpected Colors Appear
Ih\l

e

The print head nozzles may be clogged. Perform a nozzle check to check if the print head nozzles are clogged.
Clean the print head if any of the print head nozzles are clogged.

Related Information
= “Checking and Cleaning the Print Head” on page 103

Colored Banding Appears at Intervals of Approximately 2.5 cm

[ Select the appropriate paper type setting for the type of paper loaded in the printer.
[ Align the print head from a computer.

[ When printing on plain paper, print using a higher quality setting.

Related Information

= “List of Paper Types” on page 39

= “Aligning the Print Head - Windows” on page 105
= “Aligning the Print Head - Mac OS” on page 106

145



User's Guide

Solving Problems

Blurry Prints, Vertical Banding, or Misalignment

SINATET ane
y Avtdrack. W

J { 3008 "Regel

Align the print head.

Related Information

= “Aligning the Print Head” on page 105

Print Quality Does Not Improve Even After Aligning the Print Head

During bidirectional (or high speed) printing, the print head prints while moving in both directions, and vertical
lines may be misaligned. If print quality does not improve, disable the bidirectional (or high speed) setting.
Disabling this setting may slow down printing speed.

J Windows
Clear High Speed on the printer driver’s More Options tab.

1 Mac OS

Select System Preferences from the ;‘. menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select Off as the High Speed Printing
setting.

Print Quality is Poor

Check the following if the print quality is poor due to blurry prints, banding, missing colors, faded colors, and
misalignment in the prints.

Checking the printer
(d Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

(d Align the print head.

Checking the paper

[d Use paper supported by this printer.

(4 Do not print on paper that is damp, damaged, or too old.
(4 If the paper is curled or the envelope is puffed up, flatten it.
[d Do not stack the paper immediately after printing.

[d Dry the printouts completely before filing or displaying them. When drying the printouts, avoid direct sun light,
do not use a dryer, and do not touch the printed side of paper.
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[d When printing images or photos, Epson recommends using genuine Epson paper rather than plain paper. Print
on the printable side of the genuine Epson paper.

Checking the print settings
[ Select the appropriate paper type setting for the type of paper loaded in the printer.
[ Print using a higher quality setting.

Checking the ink cartridge
[J Epson recommends using the ink cartridge before the date printed on the package.
[ For best results, use up ink cartridge within six months of opening the package.

[d Try to use genuine Epson ink cartridges. This product is designed to adjust colors based on the use of genuine
Epson ink cartridges. The use of non-genuine ink cartridges may cause print quality to decline.

Related Information

= “Available Paper and Capacities” on page 38

= “List of Paper Types” on page 39

= “Paper Handling Precautions” on page 37

= “Checking and Cleaning the Print Head” on page 103
= “Aligning the Print Head” on page 105

Paper Is Smeared or Scuffed

[ When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the correct
direction and slide the edge guides to the edges of the paper.

v

[ When vertical banding appears or the paper is smeared, clean the paper path.

v

[ Place the paper on a flat surface to check if it is curled. If it is, flatten it.
[d When performing manual 2-sided printing, make sure that the ink is completely dry before reloading the paper.
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Related Information
= “Loading Paper in the Rear Paper Feed” on page 39
= “Cleaning the Paper Path” on page 106

Printed Photos are Sticky

You may be printing on the wrong side of the photo paper. Make sure you are printing on the printable side.

When printing on the wrong side of the photo paper, you need to clean the paper path.

Related Information

= “Cleaning the Paper Path” on page 106

Images or Photos are Printed in Unexpected Colors
When printing from the Windows printer driver, the Epson auto photo adjustment setting is applied by default
depending on the paper type. Try change the setting.

On the More Options tab, select Custom in Color Correction, and then click Advanced. Change the Scene
Correction setting from Auto Correct to any other option. If changing the setting does not work, use any color
correction method other than PhotoEnhance in Color Management.

Related Information
= “Adjusting the Print Color” on page 69

Colors Differ from What You See on the Display
(4 Display devices such as computer screens have their own display properties. If the display is unbalanced, the
image are not displayed with proper brightness and colors. Adjust the properties of the device.

[ Light shining into the display has an effect on how the image is seen on the display. Avoid direct sunlight and
confirm the image where an appropriate illuminance is assured.

[d Colors may differ from what you see on smart devices such as smart phones or tablets with high-resolution
displays.

[d Colors on a display are not quite identical to those on paper because the display device and the printer have a
different process of producing colors.

Cannot Print Without Margins

Make borderless setting in the print settings. If you select a paper type that does not support borderless printing,
you cannot select Borderless. Select a paper type that supports borderless printing.

Related Information

= “Menu Options for Print Photos Mode” on page 52
= “Menu Options for Copy Mode” on page 75
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= “Printing Basics - Windows” on page 53
= “Printing Basics - Mac OS” on page 55

Edges of the Image are Cropped During Borderless Printing
During borderless printing, the image is slightly enlarged and the protruding area is cropped. Select a smaller
enlargement setting.

[ Windows
Click Settings next to the Borderless checkbox on the printer driver's Main tab, and then change the settings.

J Mac OS

Change the Expansion setting from the print dialog's Print Settings menu.

The Position, Size, or Margins of the Printout Are Incorrect

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.

[ When placing the originals on the scanner glass, align the corner of the original with the corner indicated by a
symbol on the frame of the scanner glass. If the edges of the copy are cropped off, move the original slightly
away from the corner.

[ When placing the originals on the scanner glass, clean the scanner glass and the document cover. If there is dust
or stains on the glass, the copy area may extend to include the dust or stains, resulting in the wrong copying
position or small images.

[ Select the appropriate paper size setting.

(d Adjust the margin setting in the application so that it falls within the printable area.

Related Information

= “Loading Paper in the Rear Paper Feed” on page 39
= “Placing Originals on the Scanner Glass” on page 43
= “Cleaning the Scanner Glass” on page 107

= “Printable Area” on page 159

Multiple Originals are Copied onto a Single Sheet

When you place multiple originals on the scanner glass to copy them separately, but they are copied onto a single
sheet, place the originals at least 5 mm apart. If the problem continues, place one original at a time.

Related Information

= “Placing Photos for Copying” on page 44

Printed Characters Are Incorrect or Garbled

[d Connect the USB cable securely to the printer and the computer.
[d Cancel any paused print jobs.
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(d Do not put the computer manually into the Hibernate mode or the Sleep mode while printing. Pages of garbled
text may be printed next time you start the computer.

Related Information

= “Canceling Printing” on page 73

The Printed Image Is Inverted

Clear any mirror image settings in the printer driver or the application.

J Windows

Clear Mirror Image on the printer driver's More Options tab.

[ Mac OS

Clear Mirror Image from the print dialog's Print Settings menu.

Mosaic-Like Patterns in the Prints

When printing images or photos, print using high-resolution data. Images on websites are often low resolution
although they look good enough on the display, and so print quality may decline.

Uneven Colors, Smears, Dots, or Straight Lines Appear in the Copied
Image

[ Clean the paper path.
[ Clean the scanner glass.

(d Do not press too hard on the original or the document cover when you are placing the originals on the scanner
glass.

(1 When the paper is smeared, lower the copy density setting.

Related Information

= “Cleaning the Paper Path” on page 106

= “Cleaning the Scanner Glass” on page 107
= “Menu Options for Copy Mode” on page 75

Moiré (Cross-Hatch) Patterns Appear in the Copied Image

Change the reduce and enlarge setting or place the original at a slightly different angle.

Related Information

= “Menu Options for Copy Mode” on page 75
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An Image of the Reverse Side of the Original Appears in the Copied
Image

[ For a thin original, place the original on the scanner glass and then place a piece of black paper over it.

[d Lower the copy density setting on the control panel.

Related Information

= “Menu Options for Copy Mode” on page 75

The Printout Problem Could Not be Cleared

If you have tried all of the solutions and have not solved the problem, try uninstalling and then reinstalling the
printer driver.

Related Information
= “Uninstalling Applications” on page 127
= “Installing Applications” on page 129

Other Printing Problems

Printing Is Too Slow

[d Close any unnecessary applications.
[d Lower the quality setting. High quality printing slows down the printing speed.

[d Enable the bidirectional (or high speed) setting. When this setting is enabled, the print head prints while
moving in both directions, and the printing speed increases.

J Windows
Select High Speed on the printer driver's More Options tab.

[d Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as the High Speed
Printing setting.
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[ Disable Quiet Mode.

[d Control Panel

From the home screen, select Quiet Mode, and then disable it.

J Windows
Select Off as the Quiet Mode setting on the printer driver's Main tab.

d Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the Quiet Mode
setting.

Printing Slows Down Dramatically During Continuous Printing

Printing slows down to prevent the printer mechanism from overheating and being damaged. However, you can
continue printing. To return to normal printing speed, leave the printer idle for at least 30 minutes. Printing speed
does not return to normal if the power is off.

Cannot Cancel Printing from a Computer Running Mac OS X v10.6.8

If you want to stop printing from your computer, make the following settings.

Run Web Config, and then select Port9100 as the Top Priority Protocol setting in AirPrint Setup. Select System

Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer, and
then add the printer again.

Related Information
= “Web Config” on page 116

Cannot Start Scanning

[d Connect the USB cable securely to the printer and the computer. If you are using a USB hub, try to connect the
printer directly to the computer.

[ If you scan at a high resolution over a network, a communication error may occur. Lower the resolution.

[d Make sure that the correct printer (scanner) is selected on Epson Scan 2.

Check whether or not the printer is recognized when using Windows

In Windows, make sure the printer (scanner) is displayed in Scanner and Camera. The printer (scanner) should be
displayed as "EPSON XXXXX (printer name)". If the printer (scanner) is not displayed, uninstall and then re-
install Epson Scan 2. See the following to access Scanner and Camera.

J Windows 10

Right-click the start button or press and hold it, select Control Panel, enter "Scanner and Camera" in the search
charm, click View scanners and cameras, and then check if the printer is displayed.
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[ Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel, enter "Scanner and Camera" in the search charm, click Show
Scanner and Camera, and then check if the printer is displayed.

J Windows 7

Click the start button and select Control Panel, enter "Scanner and Camera" in the search charm, click View
scanners and cameras, and then check if the printer is displayed.

[ Windows Vista

Click the start button, select Control Panel > Hardware and Sound > Scanners and Cameras, and then check
if the printer is displayed.

J Windows XP

Click the start button, select Control Panel > Printers and Other Hardware > Scanner and Cameras, and then
check if the printer is displayed.

Related Information
= “Uninstalling Applications” on page 127
= “Installing Applications” on page 129

Cannot Start Scanning when Using the Control Panel

[d Make sure Epson Scan 2 and Epson Event Manager are installed correctly.

[d Check the scanning setting assigned in Epson Event Manager.

Related Information
= “Epson Scan 2 (Scanner Driver)” on page 124
= “Epson Event Manager” on page 125

Scanned Image Problems

Uneven Colors, Dirt, Spots, and so on Appear when Scanning from
the Scanner Glass

[ Clean the scanner glass.
[d Remove any trash or dirt that adheres to the original.

(4 Do not press with too much force on the original or the document cover. If you press with too much force,
blurring, smudges, and spots may occur.

Related Information

= “Cleaning the Scanner Glass” on page 107
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The Image Quality Is Rough

[d Set the Mode in Epson Scan 2 according to the original you want to scan. Scan using the settings for documents
in Document Mode, and the settings for photos in Photo Mode.

(d In Epson Scan 2, adjust the image using items on the Advanced Settings tab, and then scan.

[ If the resolution is low, try increasing the resolution and then scanning.

Related Information
= “Scanning Using Epson Scan 2” on page 83
= “Menu Options for Scanning” on page 83

Offset Appears in the Background of Images

Images on the back of the original may appear in the scanned image.

(d In Epson Scan 2, select the Advanced Settings tab, and then adjust the Brightness.

This feature may not be available depending on the settings on the Main Settings tab > Image Type or other
settings on the Advanced Settings tab.

(d In Document Mode in Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text
Enhancement.

[d When scanning from the scanner glass, place black paper or a desk pad over the original.

Related Information

= “Placing Originals on the Scanner Glass” on page 43
= “Scanning Using Epson Scan 2” on page 83

= “Menu Options for Scanning” on page 83

Text is Blurred

(d In Document Mode in Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text
Enhancement.

[ Select Document Mode as the Mode in Epson Scan 2. Scan using the settings for documents in Document
Mode.

[ In Document Mode in Epson Scan 2, when Image Type on the Main Settings tab is set to Black & White,
adjust Threshold on the Advanced Settings tab. When you increase the Threshold, the black color area
becomes larger.

(4 If the resolution is low, try increasing the resolution and then scanning.
Related Information

= “Scanning Documents (Document Mode)” on page 84

= “Menu Options for Scanning” on page 83
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Moiré Patterns (Web-Like Shadows) Appear

If the original is a printed document, moiré patterns (web-like shadows) may appear in the scanned image.

(4 On the Advanced Settings tab in Epson Scan 2, set Descreening.

e J—
|
(d Change the resolution, and then scan again.

Related Information
= “Scanning Using Epson Scan 2” on page 83
= “Menu Options for Scanning” on page 83

Cannot Scan the Correct Area on the Scanner Glass

[d Make sure the original is placed correctly against the alignment marks.
[ If the edge of the scanned image is missing, move the original slightly away from the edge of the scanner glass.

[d When placing multiple originals on the scanner glass, make sure there is a gap of at least 20 mm (0.79 in.)
between the originals.

[ When scanning from the control panel and selecting the auto scan area cropping function, remove any trash or
dirt from the scanner glass and document cover. If there is any trash or dirt around the original, the scanning
range expands to include it.

Related Information

= “Placing Originals on the Scanner Glass” on page 43

Cannot Preview in Thumbnail

[ When placing multiple originals on the scanner glass, make sure there is a gap of at least 20 mm (0.79 in.)
between the originals.

[d Check that the original is placed straight.

[d Depending on the original, previewing may not be performed in Thumbnail. In this situation, clear the
Thumbnail check box at the top of the preview widow to preview the entire scanned area, and then create
marquees manually.

Related Information

= “Scanning Photos or Pictures (Photo Mode)” on page 86
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Text is Not Recognized Correctly when Saving as a Searchable PDF
(4 On the Image Format Options window in Epson Scan 2, check that Text Language is set correctly on the Text
tab.
(d Check that the original is placed straight.
[d Use an original with clear text. Text recognition may decline for the following types of originals.
(1 Originals that have been copied a number of times
[J Originals received by fax (at low resolutions)
J Originals on which the letter spacing or line spacing is too small
[ Originals with ruled lines or underlining over the text
1 Originals with hand-written text

1 Originals with creases or wrinkles

4 In Document Mode in Epson Scan 2, when Image Type on the Main Settings tab is set to Black & White,
adjust Threshold on the Advanced Settings tab. When you increase the Threshold, black becomes stronger.

(1 In Document Mode in Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text
Enhancement.

Related Information

= “Scanning Documents (Document Mode)” on page 84

Cannot Solve Problems in the Scanned Image

If you have tried all of the solutions and have not solved the problem, initialize the Epson Scan 2 settings using
Epson Scan 2 Utility.

Note:

Epson Scan 2 Utility is an application that comes with Epson Scan 2.

1. Start Epson Scan 2 Utility.

(d Windows 10
Click the start button, and then select EPSON > Epson Scan 2 Utility.

J Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[ Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan

2 Utility.
4 Mac OS
Select Go > Applications > Epson Software > Epson Scan 2 Utility.

2. Select the Other tab.

3. Click Reset.

Note:
If initialization does not solve the problem, uninstall and re-install Epson Scan 2.
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Related Information
= “Uninstalling Applications” on page 127
= “Installing Applications” on page 129

Other Scanning Problems

Scanning Is Too Slow

Lower the resolution.

Related Information
= “Scanning Using Epson Scan 2” on page 83
= “Menu Options for Scanning” on page 83

Scanning Stops when Scanning to PDF/Multi-TIFF

(4 When scanning using Epson Scan 2, you can continuously scan up to 999 pages in PDF format and up to 200
pages in Multi-TIFF format.

[d When scanning large volumes, we recommend scanning in grayscale.
[ Increase the free space on the computer's hard disk. Scanning may stop if there is not enough free space.

[d Try scanning at a lower resolution. Scanning stops if the total data size reaches the limit.

Related Information
= “Scanning Using Epson Scan 2” on page 83
= “Menu Options for Scanning” on page 83

Other Problems

Slight Electric Shock when Touching the Printer

If many peripherals are connected to the computer, you may feel a slight electric shock when touching the printer.
Install a ground wire to the computer that is connected to the printer.

Operation Sounds Are Loud

If operations sounds are too loud, enable Quiet Mode. Enabling this feature may reduce printing speed.
Depending on the paper type and print quality settings you selected, there may be no difference in the printer's
noise level.
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[ Control Panel

From the home screen, select Quiet Mode, and then enable it.

[ Windows
Enable Quiet Mode on the Main tab in the printer driver.
d Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select On as the Quiet Mode setting.

Cannot Save the Data to a Memory Card

(d Use a memory card which is supported by the printer.
[d Check that the memory card is not write protected.

[d Check that the memory card has enough available memory. If the available memory is low, data cannot be
saved.

Related Information

= “Supported Memory Card Specifications” on page 162

Application Is Blocked by a Firewall (for Windows Only)

Add the application to the Windows Firewall allowed program in security settings on the Control Panel.

"?"Is Displayed on the Photo Selection Screen

"?" is displayed on the LCD screen when the image file is not supported by the product.

Related Information

= “Supported Data Specifications” on page 163
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Technical Specifications
Printer Specifications
Print Head Nozzle Placement Black ink nozzles: 180

Color ink nozzles: 59 for each color

Weight of Paper” Plain Paper 64 to 90 g/m*(17 to 24lb)

Envelopes Envelope #10, DL, C6: 75 to 90 g/m’ (20 to 24 Ib)

* Even when the paper thickness is within this range, the paper may not feed in the printer or the print quality may decline
depending on the paper properties or quality.

Printable Area

Printable Area for Single Sheets

Print quality may decline in the shaded areas due to the printer's mechanism.

Printing with borders

A :[C A 3.0mm (0.121n.)
B 3.0mm (0.12in.)
C 40.0 mm (1.57 in.)
D 320 mm (1.26in.)
A+ jD
H H
B B

Borderless printing

A A 43.0mm (1.69in.)

B 35.0mm (1.38in.)
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Printable Area for Envelopes

Print quality may decline in the shaded areas due to the printer's mechanism.

AH IC A 3.0mm (0.12in.)
B 5.0 mm (0.20 in.)
C 18.0 mm (0.71in.)
A Lj[ D D 40.0 mm (1.57 in.)
B B

Scanner Specifications

Scanner Type Flatbed

Photoelectric Device cis

Maximum Document Size 216%297 mm (8.5%11.7 in.)
A4, Letter

Resolution 1200 dpi (main scan)

2400 dpi (sub scan)

Color Depth Color

Grayscale
[ 16 bits per pixel internal

[ 8 bits per pixel external

Black and white
[ 16 bits per pixel internal

[ 1 bits per pixel external

[ 48 bits per pixel internal (16 bits per pixel per color internal)

[ 24 bits per pixel external (8 bits per pixel per color external)

Light Source LED

Interface Specifications

For Computer Hi-Speed USB
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Network Functions and IPv4/IPv6
Functions Supported Remarks
Network Printing EpsonNet Print (Windows) IPv4 v -
Standard TCP/IP (Windows) IPv4, IPv6 v -
WSD Printing (Windows) IPv4, IPv6 v Windows Vista or
later
Bonjour Printing (Mac OS) IPv4, IPv6 v -
IPP Printing (Windows, Mac IPv4, IPv6 v -
0S)
UPnP Printing IPv4 - Information
appliance
PictBridge Printing (Wi-Fi) IPv4 - Digital camera
Epson Connect (Email Print, IPv4 v -
Remote Print)
AirPrint (i0S, Mac OS) IPv4, IPv6 v iOS 5 or later, Mac
OS Xv10.7 or later
Google Cloud Print IPv4, IPv6 v -
Network Scanning Epson Scan 2 IPv4, IPv6 v -
Event Manager IPv4 v -
Epson Connect (Scan to IPv4 v -
Cloud)
AirPrint (Scan) IPv4, IPv6 v 0OS X Mavericks or
later
ADF (2-sided scanning) - -
Fax Send a fax IPv4 - -
Receive a fax IPv4 - -
AirPrint (Faxout) IPv4, IPv6 - -

Wi-Fi Specifications

Standards

IEEE802.11b/g/n"1"2

Frequency Range

24 GHz

Maximum Radio-Frequency Power

Transmitted

17 dBm (EIRP)

Coordination Modes

Infrastructure, Wi-Fi Direct (Simple AP)"3
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Wireless Securities ™

WEP (64/128bit), WPA2-PSK (AES)™

*1  Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.

*2  |EEE802.11n is only available for the HT20.

*3  Not supported for IEEE 802.11b.

*4  Wi-Fi Direct supports WPA2-PSK (AES) only.

*5  Complies with WPA2 standards with support for WPA/WPA2 Personal.

Security Protocol

SSL/TLS

HTTPS Server/Client, IPPS

Supported Third Party Services

AirPrint

Print

iOS 5 or later/Mac OS X v10.7.x or later

Scan

OS X Mavericks or later

Google Cloud Print

External Storage Device Specifications

Supported Memory Card Specifications

Compatible Memory Cards

Maximum Capacities

miniSD” 2GB
miniSDHC” 32GB
microSD” 2GB
microSDHC” 32GB
microSDXC”* 64 GB
SD 2GB
SDHC 32GB
SDXC 64 GB

*

Attach an adapter to fit the memory card slot. Otherwise, the card may get stuck.
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Supported Data Specifications

File Format JPEGs (*.JPG) with the Exif Version 2.3 standard taken by digital cameras DCF*!
version 1.0 or 2.0"2 compliant

Image Size Horizontal: 80 to 10200 pixels
Vertical: 80 to 10200 pixels

File Size Less than 2 GB

Maximum Number of Files 9990*3

*1  Design rule for Camera File system.

*2  Photo data stored in the built-in memory of a digital camera is not supported.

*3  Upto 999 files can be displayed at a time. (If the number of files exceeds 999, the files are displayed in groups.)

Note:

"?" is displayed on the LCD screen when the printer cannot recognize the image file. In this situation, if you select a multiple

image layout, blank sections will be printed.

Dimensions

Dimensions

Storage

d Width:390 mm (15.4in.)
(1 Depth:300 mm (11.8in.)
(1 Height: 146 mm (5.7 in.)

Printing

d Width:390 mm (15.4in.)
(1 Depth: 528 mm (20.8 in.)
1 Height: 279 mm (11.0in.)

Weight”

Approx. 4.3 kg (9.5 Ib)

*  Without the ink cartridges and the power cord.

Electrical Specifications

Model 100 to 240 V Model 220 to 240V Model
Rated Frequency Range 50 to 60 Hz 50 to 60 Hz
Rated Current 0.5t00.3A 03A

Power Consumption (with USB Con-
nection)

Standalone copying: Approx. 13.0 W
(ISO/IEC24712)

Ready mode: Approx. 4.6 W
Sleep mode: Approx. 1.6 W
Power off: Approx. 0.3 W

Standalone copying: Approx. 13.0 W
(ISO/IEC24712)

Ready mode: Approx. 4.6 W
Sleep mode: Approx. 1.6 W
Power off: Approx. 0.3 W
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Check the label on the printer for its voltage.

Environmental Specifications

Operation

Use the printer within the range shown in the following graph.

%

80

55

20

Temperature: 10 to 35°C (50 to 95°F)
Humidity: 20 to 80% RH (without condensation)

Storage

Temperature: -20 to 40°C (-4 to 104°F)"

Humidity: 5 to 85% RH (without condensation)

* You can store for one month at 40°C (104°F).

Environmental Specifications for Ink Cartridges

Storage Temperature

-30 to 40 °C (-22 to 104 °F)"

Freezing Temperature

-16°C(3.2°F)

Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

* You can store for one month at 40 °C (104 °F).

System Requirements

[ Windows 10 (32-bit, 64-bit)/Windows 8.1 (32-bit, 64-bit)/Windows 8 (32-bit, 64-bit)/Windows 7 (32-bit, 64-
bit)/Windows Vista (32-bit, 64-bit)/Windows XP SP3 or later (32-bit)/Windows XP Professional x64 Edition SP2

or later

[d macOS High Sierra/macOS Sierra/OS X El Capitan/OS X Yosemite/OS X Mavericks/OS X Mountain Lion/Mac

OS X v10.7.x/Mac OS X v10.6.8

Note:

[d Mac OS may not support some applications and features.

[d The UNIX File System (UFS) for Mac OS is not supported.
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Regulatory Information

Standards and Approvals for European Model

For European users

Hereby, Seiko Epson Corporation declares that the following radio equipment model is in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity is available at the following website.

http://www.epson.eu/conformity
C462T

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Croatia, Cyprus, Greece,
Slovenia, Malta, Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

C€

Restrictions on Copying

Observe the following restrictions to ensure the responsible and legal use of the printer.
Copying of the following items is prohibited by law:

(d Bank bills, coins, government-issued marketable securities, government bond securities, and municipal
securities

[J Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

[d Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

[d Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

[ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

Printers can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

Transporting the Printer

When you need to transport the printer to move or for repairs, follow the steps below to pack the printer.
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n Important:

 When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

1 Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the
printer from printing.

1. Turn off the printer by pressing the O button.

2. Make sure the power light turns off, and then unplug the power cord.

n Important:

Unplug the power cord when the power light is off. Otherwise, the print head does not return to the home
position causing the ink to dry, and printing may become impossible.

3. Disconnect all cables such as the power cord and USB cable.
4. Make sure there is no memory card inserted.

5. Remove all of the paper from the printer.

6. Make sure there are no originals on the printer.

7. Open the scanner unit with the document cover closed. Secure the ink cartridge holder to the case with tape.
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9. Prepare to pack the printer as shown below.

10. Pack the printer in its box, using the protective materials.

When you use the printer again, make sure you remove the tape securing the ink cartridge holder. If print quality
has declined the next time you print, clean and align the print head.

Related Information

= “Part Names and Functions” on page 14

= “Checking and Cleaning the Print Head” on page 103
= “Aligning the Print Head” on page 105

Accessing a Memory Card From a Computer

You can write or read data on an external storage device such as a memory card that has been inserted in the
printer from a computer.

n Important:

[ Insert a memory card after removing write protection.

A If an image is saved to the memory card from a computer, the image and the number of photos are not refreshed
on the LCD screen. Remove and insert the memory card again.

[ When sharing an external device inserted in the printer between computers connected over USB and over a
network, write access is only allowed to the computers that are connected by the method you selected on the
printer. To write to the external storage device, enter Setup on the control panel and select File Sharing Setup
and a connection method.

Note:
It takes a while to recognize data from a computer if a large external storage device, such as 2TB HDD, is connected.

Windows

Select an external storage device in Computer or My Computer. The data on the external storage device is
displayed.
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Note:

If you connected the printer to the network without the software disc or Web Installer, map a memory card slot or USB port
as a network drive. Open Run and enter a printer name \\XXXXX or a printer's IP address \\XXX. XXX XXX . XXX to
Open:. Right-click a device icon displayed to assign the network. The network drive appears in Computer or My Computer.

Mac OS
Select a corresponding device icon. The data on the external storage device is displayed.

Note:
[ To remove an external storage device, drag and drop the device icon to the trash icon. Otherwise, data in the shared drive
may not be displayed correctly when another external storage device is inserted.

[d To access an external storage device through the network, select Go > Connect to Server from the menu on the desktop.
Enter a printer name cifs://XXXXX or smb://XXXXX (Where "XXXXX" is the printer name) in the Server Address, and
then click Connect.

Related Information
= “Inserting a Memory Card” on page 45
= “Supported Memory Card Specifications” on page 162

Where to Get Help

Technical Support Web Site

If you need further help, visit the Epson support website shown below. Select your country or region and go to the
support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also
available from the site.

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If your Epson product is not operating properly and you cannot solve the problem, contact Epson support services
for assistance.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product manuals, contact Epson support services for assistance. If Epson support for your area
is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

[ Product serial number

(The serial number label is usually on the back of the product.)
(4 Product model
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[ Product software version

(Click About, Version Info, or a similar button in the product software.)
[d Brand and model of your computer
(J Your computer operating system name and version

[d Names and versions of the software applications you normally use with your product
Note:
Depending on the product, network settings may be stored in the product’s memory. Due to breakdown or repair of a

product, settings may be lost. Epson shall not be responsible for the loss of any data, for backing up or recovering settings
even during a warranty period. We recommend that you make your own backup data or take notes.

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.
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